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1.   INTRO 

XRadio is the new solution by AxelTech that extends the concept of Radio Automation to a full Audio and Media 

Content Management & Publishing platform. XRadio is rooted in the solid ground of AxelTech well known DJPro 

Radio Automation: that know-how evolved to provide renewed and enhanced tools to handle run the large variety 

of content that any Radio Station has to manage nowadays. 

 

XRadio is a flexible and scalable solution, perfect to match the needs of different size organizations from Regional 

to National Networks: XRadio manages one or more Radio Stations with simultaneous and multiple playouts to 

provide different Broadcast Areas with Advertisement Splits. 

 

 GENERAL FEATURES 
 

• Stand-alone or client/server configuration with unlimited clients 

• Unlimited stations/channels 

• Automatic failover to a secondary server/archive 

• Modular design by functionality (On-Air, Production, Programming, etc…) 

• Advanced XML Data Exchange 

• MsSQL Database 

• Cloud and IP workflows compatible 

• Skin customization 

• One click concept mode 

• Drag and drop interaction 

• Interfacing with both proprietary and third-party audio mixers 

• Automatic ingest from folder or FTP 

• Advanced interface for third-party systems (scheduling, news, etc…) 

• GPIO triggers (Moxa, Lawo, Advantech, Axia, Com port, etc…) 

• Advanced TCP/IP, UDP, SNMP, HTTP triggers 

• WDM and ASIO drivers 

• Audio over IP interfaces (Dante, Ravenna, Livewire, etc…) 

• IP Streaming 

• Plays any audio file 

• Plays any video file for visual radio 

• RDS management via XML and UECP, EPG, playlist and metadata WEB integration 

• Complete system administrator tools, rights management on features and modules 
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2.   FIRST INSTALLATION AND CONFIGURATION 

 

Before proceeding with the XRADIO system installation, we kindly ask you to carefully read this guide in all its parts 

and follow all the installation procedures. 

 

Minimum requirements for the installation: 

- To be familiar with Windows operating system; 

- To be able to install audio cards; 

- To know the basics of network systems. 

 

 

System setup: 

For a correct installation and system setup procedure, you have to follow these steps: 

1. OS settings; 

2. Audio card installation; 

3. MS SQL Server installation 

4. XRadio Software installation 

5. First time run of XRadio system 

 

 OPERATING SYSTEM SETTINGS 
 

Be sure no ‘power save’ is activated 

1  Open the Start menu 

2  Open the Control Panel 

3  Click on Power options 

4  Click on Change plan settings 

5  Select Never for both Turn off the display and Put the computer to sleep 

6  Click on Advanced settings 

7  Select Never for Turn off the hard disk after 

 

 

Disable the system sounds on Windows 

1 Open the Start menu 

2 Select the Control Panel 

3 Select Sound 

4 Select the Sounds Tab 

5 Click the Sound Scheme and set it to No Sounds 

6 Click on Apply 

7 Click on OK 

 

ATTENTION: for the workstations running OnAir, make sure you enabled, from the BIOS, the automatic power 

switch-on in case of power fault. Moreover, no user and password has to be set at Windows startup. 
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 INSTALLATION OF MS SQL SERVER 
 

Launch setup and choose CUSTOM installation 

 
 

 

Leave or change the path for extracting installation files and choose OK. 

In the window that opens, choose New SQL Server stand-alone installation or add features to an existing 

installation 

 
 

Accept the license terms and press Next 
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Select Use Microsoft update to check for updates (recommended) and press Next 

 
 

 

In Feature selection, leave the check mark only on Database Engine Services and press Next 
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In Instance configuration, set the name of the instance you want to create in Instance ID and press Next 

 
IMPORTANT: if you install multiple instances on that machine, give a unique and meaningful name; if you think that 

you will never create further instances, you can leave the default name. 

 

In Server configuration, set both SQL server Database Engine and SQL Server Browser to Automatic and press Next 
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NOTE: If you are configuring standard SQL, also set Automatic to SQL Server Agent 

 

In Database Engine Configuration, select Mixed Mode (SQL server authentication and Windows authentication) 

and set a password. 

Click on Add Current user (if it is not already created by default) to add the windows user. 

Press Next. 

 
 



 
 

 
 

XRadio· User Manual · ENG 

FIRST INSTALLATION AND CONFIGURATION |INSTALLATION OF MS SQL SERVER 

 

Once the installation is complete, a window summarizing the outcome of the operations appears. 

 
Press Close. 

 

 

Open Windows menu and select SQL Server 20xx Configuration 

 
 

 

Go to SQL Server Network Configuration and then to Protocols for SQLEXPRESS (or Protocols for MYSQL Server if 

it is a SQL Standard) and check if TCP/IP is enabled or disabled. 
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If it is disabled, double click on it and enable it by setting YES 

 
 

 

To activate the change, select SQL Server Services from the tree menu, right-click the SQL Server item and click 

Restart. 

 
 

 

Windows Firewall configuration 

 

Rule for SQLServr.exe 

1. Open Windows Defender Firewall and choose Advanced settings from the left menu. 

2. Select Inbound Rules and click on New Rule. 

3. In the Wizard that appears, select Program and click Next. 

4. Select the path to SQLServr.exe in This Program Path and click Next. If you are using SQL Express, the path is C:\ 

Program Files\ Microsoft SQL Server\ MSSQL15.SQLEXPRESS\ MSSQL\ Binn\ SQLServr.exe 

5. Select Allow the connection and click Next 
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6. Select the network type to which you want to apply the rule and click Next 

7. Specify a name for the rule (e.g. SQL Server) and click Finish 

 

Rule for TCP port 

1. Open Windows Defender Firewall and choose Advanced settings from the left menu. 

2. Select Inbound Rules and click on New Rule. 

3. In the Wizard that appears, select Port and click Next. 

4. Select TCP and set 1433 in Specific local ports, then click Next 

5. Select Allow the connection and click Next 

6. Select the network type to which you want to apply the rule and click Next 

7. Specify a name for the rule (e.g. SQL Server TCP Port) and click Finish 

 

Rule for UDP port 

1. Open Windows Defender Firewall and choose Advanced settings from the left menu. 

2. Select Inbound Rules and click on New Rule. 

3. In the Wizard that appears, select Port and click Next. 

4. Select UDP and set 1434 in Specific local ports, then click Next 

5. Select Allow the connection and click Next 

6. Select the network type to which you want to apply the rule and click Next 

7. Specify a name for the rule (e.g. SQL Server UDP Port) and click Finish 

 

 

Configuring SQL Server Management 
 

After installing SQL Server Management Studio, launch it from the Microsoft SQL Server Tools menu: 

 
 

The authentication panel opens showing access via Windows user 
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Select SQL Server Authentication from the Authentication menu to log in: 

Login = sa 

Password = the one chosen when installing SQL Server 

 
Click on Connect. 

 

NOTE: if you launch SQL Server Management Studio from a PC other than the one on which you installed SQL Server, 

you must search for the Server by opening the Server name menu and selecting the <Browse for more…> item; in 

the window that appears, select the Network Servers tab, wait for the Database Engines item to appear, expand it 

by clicking on +, select the desired SQL Server from the menu that appears and click OK to confirm. 

 

 

Backup configuration and maintenance 
 

NOTE: Backup and maintenance rules are not available for SQL Server Express version 

 

 

Open Server Management Studio and select Maintenance Plains: 
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Right click, select “New Maintenance Plan…” and then assign a name to the plan (eg: Database backups). 

 
 

 

Create 3 Subplains with the names indicated below: 
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Select Full and drag and drop the Backup Database Task: 

 
 

 

Right click and Edit: 

 
 

 

Select the database that needs to be backed up: 
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And the destination folder: 

 
 

 

Select Differential, drag and drop the Back Up Database Task and right click. Configure as the previous one but select 

Differential as the backup type and apply it to all databases. 

 
 

 

Select Transaction log, drag and drop the Back Up Database Task and right click. Configure as the previous one but 

select Transaction log as the backup type and apply it to all databases. 
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Save the Maintenance plain 

 
 

 

The system automatically created 3 new Jobs: 

 
 

 

Verify that SQL Agent is active: 

 
 

 

Now you can schedule Jobs. 

Select the single Job, right click and Properties: 
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Select Schedules and then create a new schedule with New…: 

 
 

 

Plan the Job according to your preferences: 
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 INSTALLATION OF XRADIO SOFTWARE 
 

You can install XRadio in three different system types. 

 

CASE A  
DJ PRO system will be typically composed by a stand-alone 
PC (it doesn’t need an Ethernet card). 

 

CASE B 

DJ PRO system will be typically composed by two 
workstations (Client) connected on a local network (LAN), 
running DJ PRO software. Server application will run on the 
same computer running the ‘On Air’ application. 

 

CASE C 

The DJ PRO system will be typically composed by several 
workstations (Clients) connected to the Server on a local 
network (LAN). Server application will be installed on a 
dedicated PC (acting as a stand-alone server) 

 
 

 

INSTALLATION 

 

From the USB drive, double click on XRadioSetup.exe to start the installation. This installation must be executed on 

any Pc that will run Dj-Pro. 

 

The setup is divided in two parts: CLIENT and SERVER. Below, you will find the main steps of the installation. 

 

Select the language for the installation and click on Next in this window and 

in the following one. 
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Read the STANDARD-END-USER-LICENSE-AGREEMENT (EULA), select “I 

accept the terms of the license agreement” and click on Next. You will be 

asked to confirm the agreement to the terms. 

 

 

 

 

 

 

 

 

 

Then a window will appear, you can choose a Complete or Custom setup. 

 

If you select the Complete Setup (default) and click on Next, the program 

will guide you through the installation of all the available features of 

XRadio. 

 

 

 

 

 

 

 

If you select the Custom Setup and click on Next, the following window will 

appear. 

 

 

 

 

 

 

 

 

 

 

The Custom Setup is useful if you already installed the Server part and you need to install only the Client in a new 

Pc, so you can uncheck the “XRadio Server” option. 

 

Once you have selected your preferences, click on Next and the program will start installing XRadio Client into 

C:\Program Files(x86). 
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If you have selected the Complete Setup, the program, then, will automatically start XRadio Server installation. 

 

 
 

If you have already run the installation before, on the same Client or on another Client that shares the same M:\ 

drive, a window ill appear. Choose “Maintain or update the instance of this application selected below”, select the 

related instance, then click on “Next”. 

 

For the first installation, a utility will run and help you to map the Server unit and create the folder where you will 

install XRadio 

 

You can choose between two options: 

 

Click Map Local Folder if you are installing 

XRadio on a Stand-alone PC, or if the Client PC is 

also the Server of your Radio system (case A and 

B). 

 

Click Map Network Drive if you are managing a 

Client\Server structure and you will install 

XRadio on the main Server 

 

 

 

 

 

 

 

 

If you choose Map Local Folder, you must select 

the Drive letter (e.g.: M:\) and the local folder 

that will be mapped with that letter. In our 

example, we are mapping the X:\DISKM folder 

as the M drive. 

 

 
 

Confirm, and the new mapped drive will appear 

in the Units list on the left. 
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If you choose Map Network Drive, the related 

Windows utility for mapping a network folder 

opens. 

 

Select the Drive (e.g.: M:), select the shared 

Folder in your network and enable Reconnect at 

sign-in. 

 

Click Finish to confirm. 

 

 

 

 

 

 

 

 

Once you mapped the drive, click Next to move to Step 2 of the process. 

 

Click Create folder to browse your system and 

select the Drive you mapped before (E.g.: M:\). 

Create a folder into the Drive or select an 

existing one and click OK. 

 

Throughout this guide we will use the path 

M:\RADIOX as an example. 

 

 

 

 

 

 

 

 

 

 

Click Finish to close the dialog box and proceed with the installation. 

 

A window will appear so that you can select the folder where you want to 

install the Server part. Click on Change and select the folder from the 

window that will appear, then click on OK. 

 

In our example, we are installing our data in M:\RADIOX. 
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In the “Licence Information” window, you can insert some data, such as the 

name of your Radio and Company. 

 

You can change or update these data any time from the Broadcaster Info 

section of XRadio Settings panel. 

 

 

 

 

 

 

 

 

The Server application data will be installed into the selected folder, then the installation procedure will 

automatically detect and set the audio cards installed on the Pc to be used with Dj-Pro. See paragraph below to see 

how to edit the audio card settings. 

 

The software installation will work in background, it will end ONLY when the related icons on Windows bar will 

disappear. If required, restart your Pc to complete the installation. 

 

 

 FIRST TIME RUN OF XRADIO 
 

Make sure you inserted the hardware key (dongle) in a USB port of any PC running the Dj-Pro Client. 

 

NOTE: if you are working on a Client-Server based system, you must start the Server before any other workstation, 

in order to have its shared sources available on the Clients. 

 

 

Double click on the XRadio icon on the desktop to run the program 

 

A window will appear where you must insert Username and Password. 
 
For the first access, insert admin as the username, no password, and click OK. 
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The first time you double click on the XRadio icon to run the program, a 

Wizard will start and guide you to the basic configuration of the program. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Next to continue, and the Audio Card settings window appears with 

the list of all the available audio devices on the machine, divided by outputs 

and inputs. 

 

 

 

 

 

 

 

 

 

Delete all the devices you do not want to use in XRadio and order the 

remaining ones. 

 

 

 

 

 

 

 

 

 

 

Click Next to open the window where can choose the audio devices you 

want to user for the audio editor and the default audio format that will be 

used when you will record or import the audio files into the system. 

 

Click Finish to save the settings and confirm. 

 

 

 

 

 

 

 

To know more about the Audio Card Configuration, see paragraph 8.10 
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In the Database mode window, select which SQL Server type you want to use: Remote Host (default) or Local Host. 

If you select the Remote Host, click on Browse to open a window where you will insert the connection data to the 

SQL Server: 

- Driver: SQL Server 

- Server: click on the arrow button to load the list of available SQL 

Servers and select one 

- Username and Password: insert the username and password you 

previously set to access the SQL Server 

- Database: write a name for the scheme that will be created to be 

the database of your system 

Click Test to if you want to check the connection to the selected Server. 

 

 

 

Click OK to save the settings, the selected configuration will appear under 

the Browse button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Station type between Radio (default) and Radio + TV (for Visual 

Radio systems) then press Next.  

In our example, we select Radio. 
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Select the Workstation role among: 

Editing, if you want to use the workstation to manage data and schedule 

OnAir, if you want to use the workstation for the OnAir playout only. 

OnAir+Editing, if you want to use the workstation for both . 

 

Press Next. 

 

In our example, we select OnAir+Editing. 

 

 

 

 

 

 

 

 

In the On-Air Audio Cards configuration, set the audio outputs and inputs 

you want to use for Playout, Preview (CUE), Keyboards (Hot Keys) Monitor 

(broadcast of an external audio signal) and Rec, according to the devices 

you previously configured in the Audio Card settings, then click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

A window with the Summary of all the selected settings will appear; click 

Next to apply them and start the creation of SQL structure. 
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3.   WORK AREA 

The setup of the main interface is strictly connected to the user you are accessing with. In the following paragraph, 

we will show the setup related to the default admin user. 

 

The Tools menu on the left shows the currently available applications of the program, while the Library, which shows 

the content of the selected audio table, occupies the most part of the window. Below the table, you can find the 

info of the selected item into the table, divided into different sections (tabs). 

 

The Toolbar on top of the window contains the buttons with the main functions associated to the selected table, 

and the Menu bar with all the program settings. 

 

The Status bar at the bottom of the window gives the user several information such as the current View, the current 

User, the license number of the software and the current Source (to know more, see Source Autochange paragraph). 

 

 
 

The work area starts with a default aspect, that is the one shown in this user guide, but you can change it any time 

according to your needs by going to View→Aspect→Skin where you will find the list of all the available skin presets. 

Select one of the skins to apply it in realt time. Moreover, according to the skin you selected, you can also choose 

among a different set of colors that you can choose from View→Aspect→Skin Palettes. 

 

 USER ACCESS 
 

Double click XRadio icon on the desktop to access the program: select the Radio Station (if you installed more than 

one XRadio Server instance in your system), insert username and password (default user is ADMIN, no password) 

and click OK to confirm. 

 

When Xradio is already open, you can change User any time by selecting File→Disconnect from the Menu bar: Xradio 

instance will close, and you will be asked to insert username and password again. 
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 TOOLS MENU 
 

The main items that appear in the Tools menu are: 

 

Library: it is the collection of all the audio categories composing the Radio 

database, that appears on the main area of the window. 

Scheduling: opens the tool for the Schedule management. 

Traffic scheduling: opens the tools to manage the Traffic data view and export. 

Administrator Tools: collects all the tools related to the administrative 

management of XRadio system. 

VJPro: runs Axel Technology’s VjPro application, if it is installed on the 

machine. 

OnAir Accessories: allows you to access the OnAir settings and the History Log. 

News Manager: opens the tool for the creation and management of News 

Bulletins. 

OnAir: shows the link to run the OnAir playout. More links can be added, 

according the different types of OnAir you will manage (emergency, edit, 

test…). 

 

In the section under the Tools menu, the Now playing box is showing the item 

that is currently played by the main OnAir playout, while the Template box 

shows which scheduling template is currently in use. 

 

Under the Now playing box, a small player allows you to play the item 

currently selected in the Library. The output used for the playout is the one 

you have set for the Internal Editor in the Audio Card configuration. 

 

In the Station box you have the info related to the current Radio station 

(XRadio can manage more than one Radio station in the same installation), the 

logged User and the current SQL Server string (point the mouse on the icon 

next to the logo). 

 

If you are managing more than one Radio station, you can use the Station 

menu to switch from one Radio station to another by selecting it in the drop-

down menu: this action will close the current Xradio instance and you will be 

asked again to insert username and password to run the new instance. 

 

 

 

 

 

  



 
    

 
30 WORK AREA |LIBRARY 

 

XRadio· User Manual · ENG 

 
 

 LIBRARY 
 

 
 

When you open XRadio, the Library starts by showing the Songs table. If you want to change the audio category to 

work on, click on another tab on top of the Library window. 

If you want to change the display order of the tables, you can drag&drop a table in the new position by its tab. 

If you want to add or remove a table from the Library, select Tables from the Options menu on the top left of the 

main window, and a selection box will appear 

 

You can use the options on the right to sort the items alphabetically, or to 

move them individually using the arrow buttons. The sorting order set in 

this list will also affect the display order of the tables in the Library. 

 

Select the tables you want to show and unselect the ones you want to hide, 

then click OK to confirm. 

 

 

 

 

 

Each table starts with a default view, but you can modify it by moving, adding, or removing the available fields: 

 

- To change the position of a field, drag&drop its column header into the new position. 

- To remove a field from the view, drag&drop its column header on the top part of the window, until you see the 

mouse pointer turning into a big X. 

- To add a field into the current view, right click on a column header and select Column chooser from the context 

menu; double click or drag&drop an item from the Customization menu to add it into the table. 

- To save the current View, select Save→Save as… from the View menu on the top left of the main window, assign 

a description to the new View and click OK to confirm. 

- To load a View you previously saved, select Load from the View menu, and click on the View you want to load. 
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XRadio will automatically save the View of each table when you close the program, so that you will start with the 

last loaded View when you will open XRadio the next time. 

 

 

As already mentioned, in the upper part of the window there is the Toolbar with the main functions 

associated to the selected table. Alternatively, you can invoke the same functions when you right-click on 

an item into the table and open the context menu. 

 

 

 

 

 

 

 

 

 

 

 

3.3.A HOW TO MANAGE DATA INTO A TABLE 
 

ORDER 

You can order a table by each field: click once on the column header of a field to sort it in ascending order (A-Z); click 

a second time on the same column header to sort the field in descending order (Z-A). 

Once you ordered the table by a field, you can set a sub-order with a second field. For example, in the Songs table 

click once on the header of Rotation category, then right click on the header of Artist and choose Sort Ascending: 

with this configuration, the Songs table is ordered by Rotation category, and all the songs with the same Rotation 

category are ordered by Artist. 

 

You can also group the table data in sub-tables by a field: drag the column header of a field into the empty space 

above, and the table will change aspect by grouping its data according to the selected field. For example, if you group 

the table by Rotation category, the aspect will be the following: 

 

Click the arrow next to each item to expand the content of the sub-table 

that can be ordered with same options as the full table. 

 

When you want to go back to the default view, move back the gouping field 

with drag&drop into the headers row, or move it on top of the window to 

remove it from the current view. 

 

 

 

 

 

SEARCH 

There are different ways to search an item into a table: 

 

1)  If you want to move into the table data, you can scroll up/down the table using the vertical scroll bar on the right 

or use the navigation bar at the bottom left of the table that allows you to move one line forward or backward, 

one page forward or backward, at the beginning or at the end of the table data. The navigation bar also tells 

you what the currently selected line is. 
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2) If you exactly know what the item you are looking for is, order the table by a field (eg: Title), then click into an item 

of that field and start typing the first characters of the item you are searching, and the software will 

automatically move on the item which starts with the characters you typed. 

3)  If you don’t know the exact string, or you want to search all the items containing the same word, click the 

magnifying glass icon on the top right of the table and type the search string into the box: the program will filter 

the content of the table, showing you only the items containing the string into ANY of their fields. For example, 

if you type the string “IMAGINE” in the Songs table, the results will show you IMAGINE by JOHN LENNON, but 

also all the songs by IMAGINE DRAGONS. Click on the x next to the search string to remove the filter and show 

the full content of the table. 

4)  If you need to do a deep search to filter the content of a table, right click one of the column headers and select 

Filter Editor from the context menu: the Filter Editor window opens, where you can set one or more filtering 

rules and decide if AT LEAST one of them must be satisfied (OR condition), or ALL of them at the same time (AND 

condition). For example, if you want to search for all the songs which Rotation Category is different than “GOLD”, 

and which Artist begins with “THE”, the filter editor must be set in this way: 

 
 

Click OK to confirm, and the result will be: 

 
The set filter is shown at the bottom of the table. You can disable/enable the filter by unslecting/selecting the 

checkbox on its left. If you want to remove and hide the active filter, click the x on its left. 

 

If you create more filters with the Filter Editor, the last created filters 

are temporary saved in a menu that you can display clicking the arrow 

on the right of the active filter at the bottom of the table. 

 

 

 

If you want to remove a filter from the list, click on the x icon that appears on its right when you pass the mouse on 

it. 
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3.3.B HOW TO ADD/MODIFY/DELETE AUDIO AND DATA 
 

XRadio automatically saves each audio file that you insert, import or record into the dedicated folder of the related 

audio table. Each audio table in the Library has one dedicated folder, apart for the Songs table that can manage 

different Sources (see Songs paragraph). 

If you want to change the target folder of an audio table, you can go to Options→Settings from the Menu bar and 

select Audio Manager\Categories to display the table with all the available audio categories. 

 

Double click on an item to open the edit mask: 

Here you can change the Description and the Rotation Category of the 

selected audio table, and the default audio Path for the new insertions. 

 

Click OK to confirm the changes. 

 

However, we suggest not making changes in the Categories 

section, unless strictly necessary. 

 

 

 

 

Before proceding with the insertion and recording audio in your new XRadio system, you must choose the import 

mode you will use for the audio files: from the Menu bar, go to Options→Advanced Settings and select 

Commons→Import from the left menu of the window that appears. 

 

Mode: if you select “create a link to the audio file”, when you import an audio 

into the Library the program saves the original path of the file; if you select 

“make a dedicated copy for the program” (default), when you import an 

audio the program makes a copy of the original file and saves it into the 

dedicated folder of the table you import the audio into. We suggest using 

this mode. 

 

Convert to the format of the radio: when importing an audio file into the 

Library, the audio will be converted using the format previously set in the 

Audio Card configuration. 

 

 

 

When you install XRadio, the default File Extension associated with the insertion, import and recording of new audio 

files into the Library is .MP3, but you can change it going to Options→Settings from the Menu bar and selecting File 

Extension from Common\Main Settings. 

 

 

INSERT 

You can insert a new item into a table, even if you still don’t have the associated audio: click on the Insert icon on 

the toolbar, or right click in the middle of the table and select Insert. The Insert window appears: 



 
    

 
34 WORK AREA |How To Add/Modify/Delete Audio And Data 

 

XRadio· User Manual · ENG 

 
 

The fields marked with an x icon are mandatory, which means that you must 

fill in at least those to save the data entered. The Filename is written in red 

because the audio file does not exist yet, until you will import or record it. 

Once you finished inserting all the data, you can click OK to confirm and save 

the new insertion which will appear in the table, or click Cancel if you don’t 

want to save the insertion. 

 

 

 

 

 

If you want to associate the audio file to the data, click Editor to open the Recorder and use the REC option if you 

want to record the audio, or the IMPORT options if you want to import an audio file (see paragraphs related to 

RECORDER). Once you recorded or imported the audio file, close the Recorder and click OK to confirm and save the 

new insertion. 

 

 

IMPORT 

You can import new audio items into a table using different ways: 

 

1) Open a table into the Library, then use Windows Explorer to open the folder with the audio files you want to 

import; select one or more audio files, then drag&drop them into the table. 

 

2) right click on an item of the table and select Import from the context menu, or select the Import icon 

from the toolbar, browse the folder where the files that you want to import are stored, select the file 

extension from the menu at the bottom to filter the content of the folder, select the audio files and click on Open to 

import them. 

 

3) You can set one or more folders to automatic import audio files in specific tables. Go to Options→Avanced settings 

and select Commons/AutoImport 

 

Select Enable to activate the autoimport function and click the Insert button 

to open the Importer. 
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In From section, select ImporterFromFolder from the Type menu and set the 

source folder. 

 

In To section, select ImporterToTable from the Type menu and click the [..] to 

select the target Table. 

 

Set a value in Repeat every to determine how often to check the source folder 

to import new files. 

 

Select Move to temp folder to improve the import phase. 

 

If you are using the source folder as a temporary folder, select Delete from 

source to delete the audio files from the source folder once they have been 

imported in the target table. 

 

 

 

 

 

 

 

 

 

When you import audio files with mp3 tags, they will be used to fill in some of the fields that match with the info. 

If you are importing a single audio, the editing mask will automatically open at the end of the import (see Edit 

paragraph). 

 

4) If you want to import audio tracks from a CD, click the CD Reader icon on the Toolbar which will open the CD 

Ripping window 

 

The window will show the list of audio tracks detected on the inserted CD, 

with their respective metadata that will be used to fill the audio info. 

 

The metadata will be automatically download from an online database, 

so they will be available only if the PC has an Internet connection and the 

album is famous enough to have its data in the database.  

 

If the sofware cannot download the metadata, the tracks will appear in the 

list with a generic name. 

 

 

 

Select the tracks you want to import in the audio table, the audio format, the normalization value (optional) and 

click Import to start the CD grab. A progress bar will show the status of the process. 

 

 

EDIT 

Double click an item into a table, or right click on it and select Modify from the contect menu, or select it and click 

the Modify icon in the Toolbar: all of these actions will open the editing mask 



 
    

 
36 WORK AREA |How To Export Audio And Data 

 

XRadio· User Manual · ENG 

 
 

Make all the changes you need and click OK to save and go back to the table 

view. 

 

If you click on <OK, you will save the changes of the current item and will 

move to the previous item in the table without closing the editing mask.  

 

If you click on OK>, you will save the changes of the current item and will 

move to the next item in the table without closing the editing mask. 

 

 

 

You can also edit more than one item at the same time, selecting them into the table using the Ctrl and Shift keys 

and opening the editing mask.  

For example, if you want to assign the same Rotation Category to some songs, select all the related items into the 

Song table by keeping the Ctrl key pressed and clicking each of them, then click the Modify icon on the Toolbar and 

the editing mask will open showing you only the fields that can be changed. Write the value in the Rotation Category 

field and click OK to confirm the changes and go back to the table View. 

 

 

DELETE 

To delete an item from a table, select it and press DEL on the keyboard, or click the Delete button on the Toolbar, or 

right click on it and select Delete from the context menu. 

 

Like for the editing, you can use the Ctrl and Shift keys to select more than one item and delete them all together. 

 

NOTE: when you delete an item from an audio table, the software deletes the data only, while the related audio file 
remains in the associated path. Which means that, as you delete audio from the various tables, you will have more 

and more files not associated with any data, and therefore unusable in your system. If you want to search for and 

delete these "orphaned" files, you can use the "Audio Without Data" function available in Administrator Tools (see 

related paragraph). 

 

 

3.3.C HOW TO EXPORT AUDIO AND DATA 
 

You can select one or more items into an audio Table, right click on the selection and choose Export to copy/move 

the audio with its data. There are three different destinations you can export data to. 

 

EXPORT TO A FOLDER 

The audio files of selected items will be saved into the folder you will choose, assigning the Description or Title – 

Artist as the file name. The export will also generate an XML file containing all the metadata of the exported audio, 

it can be used to import the items together with the data in another XRadio system using the Import Wizard tool 

(see paragraph 8.7). 

 

EXPORT TO A TABLE 

The selected items will be exported to another audio Table of your system. You can decide whether to copy or move 

the data, leaving the audio files in their original position or making a copy of them in the destination folder. 

 

EXPORT TO ANOTHER STATION 

It works only with the Songs table. The selected items will be exported to another XRadio structure into the same 

network as the original one. 
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Prerequisite: for this type of export to work correctly, the target Radio must have the Songs table configured with at 

least two Sources, where the first Source is identical to that of the source Radio and the second Source is the main 

one in which the audio of the songs you insert directly is saved. 

To configure the export to another XRadio structure, you must open the Settings from the Options menu, go to 

Common\Export to another station and select the Enable song sending to another musical archive parameter. Click 

on [Add] to enable the insertion mask: 

 

In the Destination Path, set the path where the databases of 

the target Radio are stored. 

Set the Path containing INI destination files of the Radio 

station that will receive the data, which is 

M:\RADIOFOLDER\BIN\WINDOWS (set the drive and the 

folder related to the target Radio). 

Set a description for the target Radio. 

Select Enable audio copy if you want to make a dedicated 

copy of the audio in the target Radio. 

If you want to insert the parameters for another Radio, click 

again on [Add] and insert the new parameters. 

 

The Destination # menu allows you to move from the 

parameters of one Radio to the others. 

 

 

Once you have set these parameters, when you want to export any items from a table to another Radio Station in 

your network, right click on the selection and choose Export→to station: 

 

Select the Radio Station(s) you want to export the data to and click [OK] to confirm. 

If you enable Save last selection, the tool will automatically select the same Radio 

Stations every time you run it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

With this method, the export makes a copy of the selected items and will save them in the Songs table of the target 

Radio, while maintaining the same path and name as the audio file, which means there will be two items from two 

different Radio stations which have the same audio file in common. 

If you have a structure with multiple Radios whose installation path differs only from the drive in which they are 

installed (for example: M:\RADIO, N:\RADIO, P:\RADIO...), then you must enable the parameter Enable audio copy 

and select the drive letter of the target Radio from the related menu. 
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3.3.D SONGS 
 

AUDIO SOURCES 
As mentioned in the previous paragraph, each audio table has a destination folder, while the Songs table can manage 

multiple folders in which to save its audio data. When you install XRadio, the default folder where the audio of the 

songs is saved is M:\RADIOX\AUDIO\MUSIC. 

Usually, you do not need to add another folder, but it can be useful, for example, when you have reached a large 

quantity of songs (over 5000, to give a number) and you want to lighten the load on OnAir playout which becomes 

slower in opening the MUSIC folder and searching for the song to broadcast. 

 

To add a new folder for the songs, you must go to Options→Settings from the Menu bar and select Song 

Manager\Sources. 

- Click Add to open the insertion mask and set the new folder in the Path field.  

- Select Enabled to be able to use the new source in the Songs table. 

- In the Default Source menu, you must select the new Source to start saving the new songs in the new folder. 

 

You can see the folder associated with each song in the Source field of the Details tab, and you can add the Source 

column to the Songs table view with the Column Chooser. 

 

 

INSERT 
To insert a new song in the Songs table, use one of the import methods described in the previous chapter. 

Once you imported the audio, double click the item to open the editing mask, then click Editor to open the Recorder. 

 
 

The upper part of the window shows the information of the audio file, while the lower part collects almost all the 

usable functions, and the central part shows the functions of the marking points and the audio waveform. 

You can double click on the waveform to try the different display formats and choose the one you prefer, the 

Recorder will remember the last format selected for the next time you open it. 

 

First, you can set the marking points that the OnAir playout will use when playing the song: 
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 MARK IN: point in the audio from which OnAir playout will start playing the song. The audio part that is before 

this marking point will not be played. 

 INTRO: point in the audio where the initial instrumental part ends and the singer starts to sing. 

 OUTTRO: point in the audio where the singer stops singing and the instrumental tail begins. 

 MARK OUT: marking point where OnAir playout begins to fade the audio, mixing it with the next one in the 

playlist. 

MIXIN: sets the fade in ramp which will start from the MARK IN point. 

MIXOUT: sets the fade out ramp which will start from the MARK OUT point 

 

All the marking points and the mix values are graphically represented with some lines that has the same color as the 

markers: green for the MARK IN, yellow for the INTRO, purple for the OUTTRO and red for the MARK IN; the MIX IN 

/ MIX OUT curves are white. 

 

To set the MARK IN, click where you want on the waveform to place the marker, then click the related button to set 

the value. Do the same for the other marking points. 

To set the marking points with maximum precision, you can help yourself with the zoom functions on the right side 

of the waveform and use the inner arrow buttons that you find in the Audio control section to move the marker 0.03 

seconds forward or afterward, while listening to the audio frame. 

 

Hint: you can use the spacebar to play the audio: one tap will start the playout of the audio from the current position 

of the marker, while a second tap will stop the playout by placing the marker back to the starting position. 

 

You can listen to a preview of each marking point by clicking on the related PLAY button. For example, if you click to 

the PLAY button of the MARK OUT point, you will listen to the audio starting one second before the MARK OUT point 

and fading according to the MIXOUT value set. 

 

Hint: place the mouse on the second File row of the Mix section until the pointer turns into a green arrow, then click 

to open a compact Library browser. Select the IDs table and double click on an item to select it in order to load it in 

the Mix section, then set the switch next to it to ON. This operation associates a sample audio with the MARK OUT 

preview; this way it is possible to have a preview of the final result of how the end of the song will mix with the next 

audio in the playlist. 

You can do the same operations for the MARK IN preview using the first File row in the Mix section. 

 

AUDIO EDITING 

 

 

 

If you want to modify the audio file, you can use the options in the Modifiers section to cut the audio file on the left 

side or on the right side of the cursor, or you can select a portion of the waveform with drag&drop and use the option 

to cut the selection. 

For any kind of cut, you have the preview options to listen to the audio next to the marker before you will do the cut 

operation 

 

If you made a mistake in cutting the audio, you can use the UNDO function to cancel the last action. 

ATTENTION: the UNDO function can only delete the last action, it cannot go further back 

 

 

Also, in the Recorder you can use other two features that allows you to adjust the audio level of the imported file, that 

are Normalize and Change level. 
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Anyway, the Recorder is mainly used to set the marking points and record or import an audio file. Its basic audio 
editing features are available in any third-party audio editor, such as Adobe Audition, WaveLab or Sound Forge, that 
is why we usually suggest to use one of those editors to work on the audio file. 
 
You can install a third-party audio editor on the PC, then open the Recorder setup by clicking on the button on the 
top right corner, select the Settings 2 page and, in Editing application, use the […] button to browse and select the 
.exe file which runs the editor. Then, set the Command line for editing application by clicking the Def button next to 
it, so that the %nomefile% string appears. 
Click OK to save changes. 

 

 

After you have set the parameters above, if you click on the Editing button the Recorder will open the external audio 

editor and open the audio file in it, so that you can use all the advanced features to modify the audio. Once you 

finish with the operations, save the changes and close the audio editor to go back to the Recorder window, and the 

waveform will update according to the changes done. 

 

 

Once you finished working with the Recorder, close it with the X button on the top right to go back to the editing 

mask. The values of the marking points and the mix will be automatically reported in the related fields in the Details 

tab. 

 

 

DATA SECTIONS 
The Details tab collects all the default fields you are provided with when you install XRadio system, while in the User 

Fields tab the user can add up to 20 more customizable fields: for example, you can add a field where you can set 

the nationality of the song, or the gender of the singer, or a subcategory, and so on (see the related paragraphs). 

These fields can be used to better categorize the songs data and can be exploited by the Digiware advanced music 

scheduler for a deeper selection when generating the schedule. 

The SubGenre field is the only exception, since this info can be also used in the selection rules for the Rolling Clocks 

(see Schedule chapter). 

 

In the Exclusions tab you can decide which hours of the day, days of the week and months of the year you want to 

exclude the song from the OnAir automatic music selection by category (see Scheduling chapter). 

If you set the Excluded parameter, you will completely exclude the song from the automatic music selection by 

category, and its data will not be shown in the Songs table, unless you will disable the Excluded filter by clicking its 

icon on the Toolbar. 

 

In the Scheduling tab there are the additional scheduling parameters that you may use with Digiware, apart for the 

BPM (Beats Per Minute) that can be used in the Rolling Clocks too. 

Click the button with the double green arrow to automaticallly calculate the BPM of the song. 

 

In the lower part, a grid shows the information of the last four broadcast passages of the song. Place your mouse 

over one of the pie charts to see the precise date and time of transmission. 

 

In the Notes tab you find the general info of the song. In the free space under the info, you can write additional 

information that can be shown in the OnAir interface (see OnAir chapter) 

 

In the Extra data tab, you can associate an image file to the song. The selected image will appear next to the song in 

the OnAir playlist. 

Click the […] icon or the box on the right to browse your sources and create a link to an image file in a specific path 

or click the arrow icon to automatically search and download an image from Internet, according to the Title and 

Artist of the song. 
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3.3.E IDS, PROGRAMS AND OTHER AUDIO TABLES 
 

IMPORT 
The import methods for the other audio tables are the same as the Songs. The editing mask is quite the same as the 

one of the Songs table, they differ by some parameters, that we are going to explain. 

 

DETAILS tab 

Loop: if you enable this parameter, when the OnAir will play the audio it will be repeated continuously until the 

operator on the air will manually stop it or skip it. Usually it is set for the items belonging to the Bases table, in this 

way you can continuously play a backing track for the needed time, even if the related audio file is short 

 

Voice track: if you enable this parameter, the audio will behave like a voice-over (see SPECIAL CATEGORIES 

paragraph) 

 

Dynamic Duration: this parameter is used to manage audio files that are overwritten one or more times a day 

without updating their duration in the table (example: news broadcasts automatically downloaded from the 

internet). By setting this parameter, the OnAir playout will not consider the duration saved into the table, but directly 

reads the duration from the audio file when it is inserted in the playlist. 

Usually, when you set an audio with Dynamic Duration, you don’t have to set the Mark Out point because the 

duration is variable. 

When you enable this parameter, the software adds the #?# string at the end of the audio Description when it is 

displayed in the table list and in the OnAir playlist 

 

Dynamic MarkOut: this parameter is associated to the Dynamic duration. You can use this parameter if the audio 

has a final part with a fixed duration, which you do not want to broadcast (eg: final greetings with sponsorship). In 

this case, when you insert the audio in the table for the first time, you set the Mark Out point and enable both 

Dynamic Duration and Dynamic MarkOut. In this way the OnAir will calculate the duration between the Mark Out 

point and the end of the audio from the data saved in the table and will subtract it every time from the updated 

duration of the audio loaded in the playlist. 

 

EXTRA DATA tab 

Implicit commands: It is possible to associate, to each audio, scripts that allow OnAir to automatically execute 

internal commands (towards itself) or external commands (towards other OnAir playouts or other devices) when 

broadcasting this audio. These scripts can be executed at the beginning, middle and end of the audio playout. See 

the Commands and Scripts section for more info. 

 

TAG Composition: when you have, in one file, an audio montage composed of multiple items, you can use TAG 

Composition to tell the playout which audio are contained in the montage, so that their info will be written into the 

transmission logs and will be taken into consideration for future schedules. 

 

Voice Overs: usually used with long audio files. If you add one or more items to the List, taking them from any audio 

table, during the playout the OnAir will automatically lower the audio level to play one of the items in the list over 

the main item, in a rotation. The distance between one repetition and the other is given by the Repeat time 

parameter. 

 

AUDIO EDITING 

Like for the Songs, the Recorder is the main tool to manage the audio. The functions are exactly the same. In the 

following part of this chapter, we will focus on the main functions used to manage the audio of a generic category 
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IMPORT 

In addition to the import methods already explained previously, it is also possible to import an audio file via the 

Recorder, using two different methods: 

 

 

1- You can import a new audio file, by overwriting the existing one. In this case the import will replace the original 

audio file with the new one. Apart for the file type, this import method will tend to maintain the audio format 

of the imported file. 

 

2- You can insert another audio file into the existing one. In this case the import will add the new file in the position 

currently indicated by the cursor within the waveform, updating the duration of the resulting file. This import 

method always convert the imported audio to the format set in the Audio Card configuration.  

ATTENTION: Merging two audio files that have different formats generates a corrupted audio that will not be 

played correctly by OnAir 

 

3- You can import an audio track from a CD using the Reading from CD tool 

 

AUDIO RECORDING 

If you want to record an audio with the Recorder: 

- Connect an output of your mixer to the input of the sound card you have chosen to use for the internal editor in 

the Audio Card configuration. 

- Set the MONITOR selector to ON in order to have a preview of the ingested audio before starting recording and 

adjust its level by the mixer or using the GAIN control in the Recorder. 

- When you are ready, click the REC button to activate the recording that automatically starts when the audio level 

exceeds the threshold set in the VOX control (default is -36dB). If you want to start the recording as soon as you 

press the REC button, set the VOX control to OFF. 

- Click the STOP button when you want to stop the recording. 

 

 

If another audio is already loaded in the Recorder, and the OVERWRITE selector is set to ON (default), when you 

click the REC button it will be deleted and overwritten by the new recording. If you want to keep a part of the 

previous audio, set the OVERWRITE selector to OFF and place the marker in the waveform AFTER the audio part 

that you want to keep, in this way the new recording will overwrite only the part after the marker. 
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4.   SPECIAL CATEGORIES 

 

There are three tables in the Library that manage three special categories: VOICE OVERS, COMMANDS and TRAFFIC. 

The items of these tables have functions and behaviors that differ from those of the other tables. Plus, the TIME 

SIGNAL category is managed in a completely different way than the other audio categories. 

 

 VOICE OVERS 
A Voice Over can play between two other audio, overlapping to them. With this method, for example, you can pre-
record the voice of a speaker, schedule it as a Voice Over and play it on the air, thus simulating a live speech over 
the intro of a song. 
 
The behavior of Voice Overs on the air depends on several parameters, which must be set on the Voice-Overs section 

in the ON-AIR Setup. 

 

Starting now, for the rest of the paragraph: 
-  we will call TRACK any item of the playlist that is SONG, ID, BASE, STINGER, PROGRAM, AUDIO of any of the 
available categories;  
- we will call NON-TRACK any item of the playlist that is TIME SIGNAL, TRAFFIC (the final ID is considered a TRACK), 
NEWS (the ending stinger is considered a TRACK);  
- we will call AUTOMATIC ADVERTISING the Traffic not in the playlist that is automatically broadcasted by OnAir. 
 
How to read charts: 

 

 
 

There are four different types of Voice-Overs, each one with a different behavior: 

 

VOICE-OVER TYPE 0 – END ALWAYS ON THE INTRO 
 
- When the duration of the Voice-Over is higher than the INTRO of the second track, it starts over the end of the 
first track, so to finish exactly at the end of the intro 
 

 
 
 
- When the duration of the Voice-Over is lower than the INTRO of the second track, the Voice-Over starts on the 
second track’s intro, so to finish exactly at the end of the intro 
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- When the INTRO of the second track is 0, the Voice-Over is played completely on the tail of the first track, so to 
finish exactly at the end of the track 
 

 
 
 
- When the Voice-Over is between a TRACK and a NON-TRACK, the Voice-Over is played completely on the tail of 
the first track, so to finish at the end of the track 
 

 
 
 
When the Voice-Over is between a NON-TRACK and a TRACK, the Voice-Over is played completely on the second 
track (if its duration is higher than the intro, the Voice-Over will cover the vocals) 
 

 
 
 
ATTENTION: if the AUTOMATIC ADVERTISING is ready at the end of the first track, the Voice-Over could finish over 
the advertising. In order to avoid this behavior, you can enable the parameter called No transmission of 
advertisement after a Voice-over from the OnAir Setup. In this way the automatic advertising does not start if a 
Voice Over is playing, thus delaying its transmission. Alternatively, you can place the advertising clusters in the same 
schedule together with the Voice-Overs, thus avoiding the automatic playout of the advertisement. 
 
The main drawback of this Voice-Over type is that, if it is very long, the Voice-Over itself covers a good part of the 
first track. To avoid this, you can use the Voice-Over Type 1 
 
 

VOICE-OVER TYPE 1 – WITH BASE OR SILENCE BASE 
 
- When the duration of the Voice-Over is higher than the INTRO of the second track, the first track ends and the 
Voice-Over starts on a base; when a duration equal to the intro of the second track is left to the end of the Voice 
Over, the base stops and the second track starts; the Voice Over ends exactly at the end of the intro 
 

 
 
 
- If the length of the Voice-Over is lower than the second track’s intro, the base is not used and the Voice-Over starts 
together with the second track 
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If the INTRO of the second track is 0, the Voice-Over is played completely on the base 
 
 
- If the Voice-Over is between a track and a NON-TRACK, the Voice-Over is played completely on the base 
 

 
 
 
- If the Voice-Over is between a NON-TRACK and a track, the Voice-Over is played completely on the track, and in 
this case it could cover the vocals 
 

 
 
ATTENTION: if the Voice-Over is between two tracks and the AUTOMATIC ADVERTISING is ready at the end of the 
first track, the advertising will play and the Voice-Over will start at the end of the cluster. You can place the 
advertising clusters in the schedule together with the Voice-Overs, thus avoiding the automatic playout of the 
advertisement. 
 
Voice-over Bases 
If you create your schedules with DjPro’s Schedule Manager, you must specify, in the Schedule Manager Setup, 
Settings 1, a list of bases that you want to use for the Voice-Overs, choosing them from the Bases category. The 
generated list will be available in a drop-down menu when you will insert a type 1 Voice-Over into the schedule. 
 
If you create your schedules with Digiware, all the items of the Bases category will be available in a drop-down menu 
when you will insert a type 1 Voice-Over. 
 
The base that you choose for a Voice-Over in a schedule must be longer than the necessary duration, as the base 
will not play on a loop. 
 
If the base is not specified, or points to a non-existent file, ON-AIR does not play the Voice-Over properly. 
 
 

VOICE-OVER TYPE 2 – ALWAYS BETWEEN TWO SONGS 
 
- It is quite similar to Voice-Over Type 0, except when its duration is lower than the INTRO of the second track, in 
this case the Voice-Over starts together with the second track 
 

 
 
 

VOICE-OVER TYPE 3 – VOICE TRACK 
 
The Voice Tracks are Voice Overs whose start point, and end point are defined by the user in the scheduling process 
with the DjMTrack utility, or during their recording with a “Voice Track OnAir” (see OnAir chapter). 
If you schedule a Voice Track whose start point and end point have not been set, it will be played by OnAir as a Voice-
Over type 1, that is, all or part of the Voice Track will play on the base that you have chosen in the scheduling process. 
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SCHEDULING A VOICE-OVER 
 
Once you have set the parameters on the Voice-Overs section in the ON-AIR Setup, they are valid for all the Voice-
Overs that you will schedule and play on the air. 
If you do not enable the parameter called Voice-over type from DBF, all the scheduled Voice-Overs will be of the type 
that is set into the parameter called Voice-over type; otherwise, in Schedule Manager and Digiware you can set, for 
each Voice-Over, a different type and, in the case of Voice-Over type 1 and 3, a different base. 
The mask for the schedule of a Voice-Over looks like the following picture: 
 

 
 
You can select the Voice-Over type from the Type menu and, eventually, associate a base from the Voice-over Base 
menu. 
To specify the list of the available bases for the Voice-Overs, you must go to Options→Settings from the Menu bar 
and select Schedule Manager\Main Settings. 
 

4.1.A WILDCARDS 
 

In XRadio system, we call Wildcards those "voice-over" audio that announce the year, decade or artist of the song 

that is about to play, always ending on the intro of the song itself. 

 

These audio files automatically match the song according to data entered in the YEAR and ARTIST fields of the Songs 

tab in the Library. 

 

It is possible to choose to set the wildcards in two alternative ways: fixed folders or variable folders. 

 

WILDCARDS IN FIXED FOLDERS 

 

First of all, in M:\RADIO\AUDIO\ create three different folders which will contain the audio files for the wildcards. 

We suggest calling them 

AAYears 

AADecades 

AAArtists 
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Go to Option→Settings in the Menu bar and select Common\Combinable wildcards from the menu on the left:  

 

In the Path parameters you must indicate the 

path of the folders that you create before and 

will contain the audio wildcards. 

 

In the Extension parameters you must indicate 

the extension of the files used for the wildcards 

(eg: .MP3). 

 

In the Extra parameters you can choose a prefix 

for the file names (eg: Song) 

 

Click on OK to save the changes. 

 

 

 

 

 

 

 

Record the audio files and name them as follows: 

- For the YEARS, SongYYYY.ext (i.e., Song1999.mp3, Song2000.mp3, Song2001.mp3, and so on). 

- For the DECADES SongYYYx.ext (i.e., Song197x.mp3, Song198x.mp3, Song199x.mp3, Song200x.mp3, and so on). 

 

ATTENTION: YEAR and DECADE wildcards will work properly only if you have filled in the YEAR data of the songs in 

DjPro music archive (Song Manager). 

 

- For the ARTISTS, use the artist’s name as it is written in the Songs table (i.e. Vasco Rossi.mp3, Beatles.mp3, Bruce 

Springsteen.mp3, and so on). 

ATTENTION: any errors in typing the artists name in Song Manager data will cause the wildcard to malfunction. 

 

Now open the Library and select the Voice-Overs tab. 

Insert a new voice-over and assign a description that makes the wildcard recognizable in Digiware schedules and in 

the OnAir playlist. 

In FILE NAME field, set the string corresponding to the wildcard you want to use. 

The strings are as follows: 

YEAR = %YEAR% 

DECADE = %DECADE% 

ARTIST = %ARTIST% 

 

Here's what the Voice-Over tab will look like: 
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WILDCARDS IN VARIABLE FOLDERS 

 

In your system, you can use EITHER WILDCARDS IN FIXED FOLDERS OR WILDCARDS IN VARIABLE FOLDERS, not both. 

 

If you already enabled the WILDCARDS IN FIXED FOLDERS, remove the parameters from the setup: 

 

 
 

 

Select the Voice-Over tab in the Library and insert a new item. In File Name, enter a string following this syntax: 

- Path of the folder containing the audio files (e.g., M:\AUDIO\YEARS\) 

- Syntax of the wildcard, possibly preceded by a fixed syntax (e.g., A_%YEAR%) 

- File extension (e.g., .mp3) 

 

Here is the string that would result from our example: 

 

M:\AUDIO\YEARS\A_%YEAR%.MP3 

 

 

The possible wildcards are: 

 

%YEAR% for the pairing of the year 

%ARTIST% for the pairing of the artist 

%DECADE% for the pairing of the decade 

 

 

You can insert the newly created item before a song in Digiware schedule or in XRadio schedule, or manually insert 

it in OnAir playlist. 
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 COMMANDS 
 

In the Commands table you can can create and manage a wide range of commands that can be sent by OnAir through 

RS-232, TCP/IP, UDP, HTTP or GPIO and used to remotely command other programs or devices. The commands, like 

any item of the other audio categories, can be scheduled or manually inserted into OnAir playlist. 

 
You can also manage some commands, called SCRIPTS, to make the OnAir itself (or a different OnAir that is running 
on another PC) execute specific actions. 
 

To create a new command, open the Commands table in the Library, insert a new item, write a Description and, in 

the File Name, write the command string. 

 

Example: if you want to create the command to set OnAir in manual mode, you must write, in the Filename field,  

 

^^MANUAL 

 

When OnAir will “play” this item from the playlist, it wil be set in MANUAL mode. 

 

Please read the Commands And Scripts chapter to know how to write the command strings for each protocol and 

what are the methods of execution. You will find a list of the most used scripts. 

 

MULTIPLE COMMANDS 
 
It is possible to create a single string with more than one command, separated by the | (pipe) character. OnAir will 
execute the instructions in sequence, as set in the string. 
 
For example, if you want to create a command that sets the OnAir in MANUAL mode and runs a batch file, the string 
will be: 
 
^^MANUAL|^^SHELL(C:\TEST.BAT) 
 
In this way, you can create command strings by mixing scripts with TCP/IP, UDP, HTTP, RS-232 commands. 
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 TRAFFIC 
 

The daily traffic schedule is generated based on the information entered in the Traffic table. Each item of the table 

corresponds to the scheduling of a commercial, so if the customer has more commercials you need to enter more 

items. 

The schedule of a commercial is based on the selected days of the week, on the indicated time points and on the 
scheduling period set in its form. The available time points are fixed, but they can be customized. You can choose a 
miximum of 20 time points in a day for each scheduled commercial. 
The order of a commercial in the advertising cluster can be changed by setting different values of priority (1=always 
at the beginning, 9=always at the end). 
If you want the commercials to be ordered randomly into the cluster, enable the Rotation parameter that changes 

the position of the commercials having the same priority within the same advertising clusters in the scheduling. 

 

 

HOW TO MANAGE THE TIME POINTS 

 

From the Menu bar, open Options→Settings and go to Traffic Scheduler\Available Times, where you will find a table 

with the available time points. 

 

To change a time point, select it and write the new value. 

 

When you are finished with the changes, click OK to confirm. 

 

 

 

 

 

 

 

 

 

 

 

 

HOW TO SCHEDULE A COMMERCIAL 

 

Insert a new item in the Traffic table, write the name of the commercial in 

the Description field and insert the product Category (this parameter is very 

important to allow the program to warn you if you are scheduling two 

commecials of the same product category in the same time cluster). 

- Write the file name, without extension, in the related field, it will be 

automatically created and saved in M:\RADIOX\AUDIO\ADV default path 

when you will import the original audio. 

- Click Editor to open the Recorder and use an import function to select 

the original audio and import it. You don’t need to set the marking points 

for the audio of a commercial, since it will be played entirely. Close the 

Recorder. 
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- In the Scheduling tab, click a day of the week to open a window with 

the available time points of the day, select the ones that you want and click 

OK to confirm. Do the same for all the other days of the week where you 

want to schedule the commercial. 

- Select the scheduling period by setting the Start Date and the End 

Date. 

- Select a Priority and the Rotation parameter, if you need it. 

- Click OK to confirm the insertion. 

 

 

 

The generation and export of the schedule made up of all the commercials inserted in the Traffic table is managed 

by the Traffic scheduling section (see related Chapter) 

 

 

HOW TO PLAY A COMMERCIAL 

 

The exported advertising schedule is automatically detected and read by OnAir at the start of the day. 

 

• By default, when a cluster's scheduling time arrives, if both OnAir playout and Traffic panel are set to AUTOMATIC 

mode, OnAir OnAir will start the playout of the cluster at the end of the audio currently playing. 

 

• If both OnAir and Traffic panel are set to MANUAL mode, it is up to the user to decide when to start the traffic 

cluster by pressing the related PLAY button which will only be enabled when the scheduled time arrives 

 

• The user can also manually insert a cluster into the playlist by clicking on one of the [+] buttons, then on Traffic 

and choosing one of the time points from the list. With this method you can play any cluster at any time of the 

day 

 

• In the same way, you can insert any time point in any Schedule (Clocks, Events, Sequences), together with other 

items. In this way you can create a time point with a sequence where you can decide what the OnAir must play 

before and after a cluster. 

For example, in the Events Schedule, you can create the time point of 13:00 with a sequence like: 

- HIT SONG 

- TRAFFIC CLUSTER OF 13:00 

- BREAKING NEWS 

- WEATHER 

 

In this way you know that the cluster of 13:00 will go on the air AFTER the HIT SONG and BEFORE the BREAKING 

NEWS, even if it will start with a delay of some minutes, because the song plays first according to the scheduled 

sequence. 
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 TIME SIGNAL 
 

XRadio provides the Time Signal function that allows OnAir to play the exact time in any moment, by taking 

information from the PC clock. 

To manage the settings of the Time Signal, click Options from the Menu bar, select Settings and go to Audio 

Manager\Time Signal 

 

In the Available languages box you find the list 

of the different time signals. Under the box you 

can see and change the description of the 

selected time signal.  

 

In the Paths section you must select the folders 

where OnAir will pick up the audio files of the 

hours and minutes to be broadcasted. 

 

 

 

 

 

 

 

 

 

 

 

 

The Base box contains all the information dedicated to the background of the time signal. In the Base 

field you must enter the BASE FILE NAME with its path. With the proper button, you can select the audio 

file to be used as the base of the time signal directly from any DJPRO archive. 

 

Press the Edit button to open the RECORDER and edit the audio of the base, listen to the playback or 

set Mark In, Mark Out and Voice Starting. 

 

 

IN THE RECORDER: 

- MARK IN indicates the point where to begin to play the base;  

- INTRO (Voice Starting) indicates the point where to begin to play the audio of hours and minutes.  

- MARK OUT indicates the point where the Base ends and mix with the next track. 

 

MARK IN, INTRO and MARK OUT can be also modified directly from the configuration panel, without running the 

RECORDER. 

 

You can set other parameters: Time signal volume, Base signal volume and Mix. For the Time signal volume and 

the Base signal volume, values can be set from 0 to 50. 

 

The Hour menu contains the list of all possible hours (from 0 to 23). To record an hour, select it in the list and click 

the Edit button to open the RECORDER. 

 

The Minutes field contains the list of all possible minutes (from 0 to 59). To record a minute, select it in the list and 

click the Edit button to open the RECORDER. 
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XRadio Standard mode plays the time signal as a composition of the audio file of the Hour followed by the audio 

file of the Minutes. 

However, you can change the mode from the Type menu: 

1 – Unique file (full hour): when OnAir plays the time signal at an exact time (eg 12:00, 13:00, le14.00 etc..), the 

used audio file will be the one recorded in Full hours. At all other times it continues to use the Standard mode. 

2 - Unique file (Hour/Minutes): when OnAir plays the time signal, the used audio file will be the one recorded in 

Hours/Minutes. Since it would be necessary to record every minute of every hour to have the complete day (1440 

files!), this mode is used when you have the time signal at fixed times in the day, so that you can only record the 

audio of the times around the schedule time points of the time signal. 

3 – Unique File from Database: When OnAir plays the time signal, it will pick up the related audio file from the 

specified Table in the Library. In this case, the audio is played without the background base. Use the […] button to 

browse the Tables list and choose one. Like for the Type 2, you can record only the times that you need, and the 

Description of each item must be in HH:MM format (e.g:. 07:59, 08:00, 08:01…). 

 

Click OK to confirm the changes. 

 

WARNING: OnAir must play the voice of the Time Signal in the space between the set Intro and Mark Out of the 

Base, so the duration of the voice must always be less than the duration between the Intro and Mark Out of the 

Base. If the voice lasts longer than the allowed space, OnAir does not play the Time Signal it correctly. 

This rule does not apply to Unique File from Database mode, since it does not use the Base. 

 

4.4.A HOW TO PLAY THE TIME SIGNAL 
 

There are two ways to play the Time Signal: 

 

- From the OnAir playout, click on a [+] button and select Time Signal to insert it manually into the playlist. The 

OnAir will play the Default Time Signal. 

 

- If you want to schedule the Time Signal, you can insert in any schedule type and select which language to use: 
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5.   SCHEDULING 

 

 
 

The Scheduling area allows you to specify the schedule of the items that will be broadcast: the playlist of songs, IDs, 

traffic, etc. to transmit. 

 

The work area is made up of several panels, each one can be moved, resized, and closed. You can use the Panels 

menu from the Menu bar to open/close each panel. You can also load some default layouts by selecting them from 

the Presets menu. 

You can move the panels by snapping them to the various positions within the work area: try dragging one of them, 

and you will see some icons appear indicating the available snapping options; move the mouse on one of the icons 

and you will have a preview of how the panel will be positioned; release the mouse when you are on an icon to move 

the panel on the new position. 

Alternatively, you can leave the panels floating, or move them and arrange them on a second screen. 

 

The main panels are: 

 

SCHEDULE 

It contains the tables that manage the various types of schedules that are:  

Sequence/Clock: you can select a list of items from the Library (songs, IDs and other audio categories) and schedule 
it on different days and different times, using the other schedule types. 
Rolling Clock: weekly based schedule, made of several time points, each one containing a series of audio that are 
repeated cyclically. It is mainly used for composing the basic musical schedule of your Radio. 
Events Schedule: weekly based schedule, it has the priority on the Rolling Clocks. Used to schedule all those events 

that have a fixed weekly time. For example, every Tuesday at 20:00, Time Signal followed by Breaking News 

Manual Schedule: allows you to schedule, on a specific date at a specific time, events that do not need to be 

repeated. 

 

SEQUENCE LIST 

It shows the list of all the generated sequences, and for each of them you can see in which schedule, day and time 

they have been inserted. 
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LIBRARY 

The tree menu shows a list of voices of all the available audio and command categories that you can insert into a 

schedule. Clicking one of the voices that corresponds to an audio table, it expands showing the list of all its Rotation 

Categories and the number of items associated to heach category.  

In the Selection rule tab you can set the scheduling options of the item that you want to schedule by Rotation 

Category. 

The Manual selection tab shows the content of the selected table, and you can choose a specific item to be inserted 

in the schedule. 

 

CALENDAR 

The structure of the schedule currently in use is displayed in the calendar, divided by days and hours, where it is 

possible to show/hide the different types of schedule. 

 

CHART 

It shows a pie chart of the items that make up the schedule currently selected in the SCHEDULE panel. 

 

 

 HOW TO SET A SCHEDULE 
 

The first thing to know is that any change you make to the Schedule will be immediately active in the playout, as the 

OnAir reads the scheduling data every minute. In this way, it is possible to modify a schedule up to one minute 

before its loading time in the playlist. 

 

There are several ways to manage the scheduling in XRadio. In the following part of this chapter, we will describe 

some of these methods. 

 

5.1.A CREATE A CLOCK 
 

- Select Sequence/Clock tab in the SCHEDULE panel and click the [+] button on the top right to create a new Clock. 

- Write a name for the Clock (eg: MORNING MUSIC) and click OK. 

- Click the Insert button to insert the first item into the new Clock. 

- Select Songs from the tree menu and choose one of the Rotation Categories, then Click OK to confirm. 

- Do the same operations to insert an ID by Rotation Category. 

- Insert another song by changing the Rotation Category, then another ID, and so on until you have a small list of 

Songs and IDs scheduled by Rotation Category. 

 

Since you scheduled songs and IDs by Rotation Category, the Duration field of each line shows the average Duration 

of the items belonging to the scheduled category. Similarly, the total duration shown at the bottom of the panel is 

calculated with the sum of the average durations, Likewise, the total duration shown in the lower part of the panel 

is calculated with the sum of the average durations, in order to give you an idea of how long this schedule can last 

 

- Create some other Clocks, changing the sequence of songs and IDs. In our example, we create AFTERNOON MUSIC 

and EVENING MUSIC 

 

When you schedule a song by Rotation Category, you can filter the song selection by also setting a speed range 

(BPM) and one or more musical Genres. In this way OnAir will respect all these filters when selecting the song to 

insert into the playlist. 
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5.1.B HOW TO SCHEDULE ROLLING CLOCKS 
 

- Select Rolling Clock tab in the SCHEDULE panel, choose Sunday in the days menu and 00:00 in the time points 

menu (you can create customized time points in the time menu by clicking the [+] button) 

- Click Insert button, select SEQUENCE, MORNING MUSIC and click OK to insert it in the Rolling Clock. Alternatively, 

you can drag MORNING MUSIC from the SEQUENCE LIST panel directly into the SCHEDULE panel. 

 

With these simple operations, you already created a very basic schedule of the whole week, since the OnAir playout 

will use the MORNING MUSIC sequence in a loop, from Sunday to Saturday, 24/7, to automatically choose and play 

songs and IDs by the Rotation Categories set into the sequence. 

If you check the Calendar, you will see the MORNING MUSIC schedule placed at 00:00 of Sunday. 

 

- Doing the same operations as for the MORNING MUSIC, insert AFTERNOON MUSIC at 13:00 and EVENING MUSIC 

at 19:00 of Sunday. 

 

If you leave the schedule like this, OnAir will use MORNING MUSIC starting Sunday from 00:00 to 12:59, AFTERNOON 

MUSIC from 13:00 to 18:59 and EVENING MUSIC from 19:00 of Sunday up to 23:59 of Saturday. 

 

-  To copy MORNING MUSIC at 00:00 on the other days of the week, select again Rolling Clock tab in the SCHEDULE 

panel and click Export button to open the Insert mask. 

- Set 13:00 in the Time field, Rolling Clock in the Options and select all the days from Monday to Saturday, then click 

OK to confirm. 

- Do the same operations to copy AFTERNOON MUSIC every day at 13:00 and EVENING MUSIC every day at 19:00. 

 

The Calendar will show the following: 

 
 

The OnAir will use MORNING MUSIC from 00:00 to 12:59, AFTERNOON MUSIC from 13:00 to 18:59 and EVENING 

MUSIC from 19:00 to 23:59, every day of the week. 

 

The example pattern we have just illustrated is quite simple; you can create much more complex patterns by 

inserting many more Clocks and time points per day into your weekly Rolling Clocks schedule. 
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5.1.C HOW TO SCHEDULE RECURSIVE AND ONE-TIME EVENTS 
 

If you want to schedule an event, or a sequence of events, that must repeat every week in the same day at the same 

time, you must use the Events Schedule: 

- Select Events Schedule tab in the SCHEDULE panel, choose Monday from the days menu and create 21:30 in the 

time points menu using the [+] button. 

- Click Insert button, select Programs, Manual selection, choose an item (eg: BREAKING NEWS) and click OK to 

confirm. 

- Click Insert button again, select Time Signal and click OK to confirm. 

 

Every Monday at 21:30, OnAir will insert the BREAKING NEWS followed by the TIME SIGNAL on top of the playlist 

and will play them after the audio currently on the air. 

Once OnAir has played the Time Signal, if there are no other events scheduled, it will keep on playing audio using 

the current Rolling Clock. 

 

- Select Sequence/Clock tab in the SCHEDULE panel and click the [+] button on the top right to create a new Clock 

for your TOP 10 music chart. 

- Insert all the elements that make up the TOP 10 of the current week (songs, jingles, stingers, recorded voice-

overs…) 

- Select Events Schedule tab, choose Saturday from the days menu and 14:00 from the time points menu 

- Click Insert button, select SEQUENCE, choose TOP 10 and click OK to confirm, or just drag&drop TOP 10 from the 

Sequence list into the Events Schedule 

- Click Export button to open the Insert mask. 

- Set 10:00 in the Time field, Events in the Options and select Sunday, then click OK to confirm. 

 

The TOP 10 music chart will be broadcast every Saturday at 2.00 pm and a repeat on Sunday at 10.00 am. You will 

only have to update the TOP 10 Sequence with the new audio, before every Saturday. 

 

In the Calendar panel, select Show events to display the scheduled items in the Events Schedule. Place the mouse on 

a colored box to see the info about the scheduled events. 

 

WARNING: pay attention to the durations of the schedules and avoid crossing the schedule of two time points. For 

example, if you schedule at 10:00 a sequence of events, that lasts about 30 minutes, and you schedule another 

sequence of events at 10:15, OnAir will load the first sequence on top of the playlist at 10:00. At 10:15, when the 

first sequence has not yet been broadcast in its entirety, OnAir will load the second sequence on top of the playlist, 

moving the items still present in the playlist downwards. 

 

If you want to schedule an event, or a sequence of events, that will be broadcast only once, you must use the Manual 

Schedule: 

- Select Manual Schedule tab from the SCHEDULE panel, click on the [+] button to insert a date (eg: 14/10/2023), 

then select or create a time point (eg: 18:00) 

- Click Insert button, select Programs, Manual selection, choose an item (eg: INTERVIEW WITH THE PRESIDENT) and 

click OK to confirm. 

 

Only on October 14, 2023, at 6:00 pm, OnAir will insert the INTERVIEW WITH THE PRESIDENT program at the top of 

the playlist and will play it after the audio currently on the air. 

Once OnAir has played the program, if there are no other events scheduled, it will keep on playing audio using the 

current Rolling Clock. 
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WARNING: pay attention to the durations of the schedules and avoid crossing the schedule of two time points. 

Moreover, Manual Schedule has the same priority as the Events Schedule, so avoid crossing the time points of the 

two schedule types. 

 

5.1.D HOW TO SCHEDULE EVENTS AT EXACT TIME 
 

By default, OnAir inserts all the events, that you schedule in Events and Manual Schedule, on top of the playlist when 

their showtime arrives, but only plays them after the current item on the air is finished or if the user manually skips 

it. 

if you want to schedule an event that must start at a specific time, you must do as follows: 

- insert the item, or the list of items, in the desired time point of the Events or Manual Schedule. 

- as the last item, open the Insert window, select External Command from the menu and set “899 START ONAIR” in 

the Start Command field (no other parameters are needed). 

 

For example, if you create the time point of 6:30pm on Friday and you enter a sequence consisting of 

TIME SIGNAL 

TRAFFIC CLUSTER OF 18:30 

899 START ONAIR 

 

OnAir, exactly at 6:30pm on Friday, will insert the Time Signal and the Traffic cluster at the top of the playlist, will 

skip the event on the air and start the Time Signal, followed by the Traffic cluster. 

 

ATTENTION: insert the External Command always AT THE END of the list of events you want to start at an exact time. 

 

5.1.E TEMPLATES 
 

XRadio allows you to create multiple scheduling structures to manage changes in schedules based on the various 
periods of the year. 
For example, you can create a general structure, one for the summer schedule, one for the Christmas schedule, and 

so on. 

 

CREATE A NEW TEMPLATE 

- From the Menu bar of XRadio main window, go to Options→Settings and select Schedule Manager\Template 

- Select an available letter from the Template menu (eg: <A>) and write a Description (eg: Summer) 

- The Prefix field will automatically fill in with the first three letters of the Description (eg: SUM) 

- Click OK to confirm. 

- Open Scheduling window, click Template from the Menu bar and select the new template to start working on it. 

- Select Standard Schedule from the Template menu when you want to go back to the default schedule. 

 

SELECT A TEMPLATE FOR THE PLAYOUT 

- Open the OnAir Setup (see related chapter) and go to On-Air\Scheduling\Advanced 1. 

- Write the Prefix of the template (eg: SUM) in Prefix of the scheduling archives parameter and click OK to confirm. 

- In the OnAir playout window, click the UPDATE button to activate the change. 
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6.   TRAFFIC SCHEDULING 

 

The first part of the work regarding traffic schedule is managed with the Traffic table in the Library, which is where 

the user must insert every commercial and its respective scheduling periods. 

Then, in the Traffic Scheduling section, you have a preview of the scheduled commercials in the current week: 

 

 
 

To export the Traffic schedule, click Send Data and select a period using the Start Date and End Date fields, then 

confirm by clicking OK. The program will show a confirmation window at the end of the export. 

 

The export action generates, for each day of the selected period, a .TXT file containing the Traffic schedule that OnAir 

will read to play the commercials on the air. 

 

 HOW TO PLAY TRAFFIC 
 

There are several ways of playing Traffic on the air:  

 

1) with the Automatic/Manual mode of the TRAFFIC panel in the OnAir playout 

2) by manually inserting a cluster into the playlist 

3) by scheduling the clusters into Events or Manual Schedule 

 

The first method is the one ready to use when you first install XRadio. With this method, the user leaves OnAir to 

manage the preparation of the clusters to be broadcast based on their scheduling time (read the related paragraph 

in the ONAIR chapter). The limitation of this method is that you cannot know in advance at which point in the playlist 

the Traffic will be ready to air. 

 

With the other two methods, the user has more control over the placement of clusters within the playlist, regardless 

of their scheduled time. 
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If you want to manually insert one or more clusters in the 

playlist, you just must click the [+] button associated to the 

position where you want to insert the cluster, select Traffic and 

double-click on the time of the desired cluster. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to schedule one or more Traffic clusters in the Events 

or Manual Schedule, select the desired time point in the 

Scheduling panel (eg: Monday at 11:00) Click Insert button, click 

Traffic voice, select the cluster you want from the drop-down 

menu and click OK to confirm. 

 

 

 

 

 

 

 

 

 

The manual insertion and the schedule of a cluster into the playlist has the priority over the Automatic/Manual 

mode management of the TRAFFIC panel. Which means that OnAir does not automatically repeat clusters that have 

already been broadcast or are in the playlist. 
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 JINGLES ASSOCIATED TO TRAFFIC 
 

OnAir can automatically play an opening jingle and a closing jingle associated to Traffic clusters. To configure these 

jingles, go to Options→Settings and select Traffic Scheduler\Settings 2. 

 

Click the [+] button next to the Opening box to 

browse the IDs table and select one item as the 

starting jingle. 

Do the same in the Closing box for the ending 

jingle. 

Select the first empty line in the opening box and 

in the Closing box and use the [-] button to 

delete them. 

 

If you want, you can also set a Break jingle that 

OnAir will play between one commercial and the 

other into the cluster. 

 

 

 

 

 

 

 

By default, XRadio chooses the jingles from the Library's IDs table, but you can use another table by selecting it in 

the Table field. 

 

If you add more jingles in the Opening list and in the Closing list, OnAir will use them in a rotation by choosing one 

for each cluster. 
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7.   ONAIR 

 INTRODUCTION 
 
OnAir is the program for the playout; it allows you to broadcast songs, news, traffic and all the available audio, for 
a complete radio automation. 
 

 
 

 USING THE PROGRAM 
 
The use of OnAir is simple and intuitive, it is divided into separate areas and the buttons are user friendly. 
 

7.2.A PLAYLIST 
 

 

On the left there is a list of the events waiting to be transmitted (playlist).  
The event on top (step 1) shows what OnAir is currently broadcasting, while below there is the complete sequence of loaded 
steps. 
It is possible to scroll through this list by pressing the arrow buttons that allow you to move one step at a time, one page at a 
time or to go directly on top or bottom of the list. These buttons are displayed on the right of the playlist. 

 
Each step is described by the following data: 
<TITLE> <ARTIST> <ROTATION CATEGORY> <YEAR> <ALBUM> <DURATION> <INTRO> <OUTTRO> <SCHEDULE TIME> 
<AIR TIME> <MIXOUT>. 
 
Note: The displayed data can change their meaning, according to the type of the aired event (the information of a 
song is different from those of a News Bulletin). 
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Also, under the number of each step you can see a colored band that represents the macro-category to which the 
event belongs, as well as the thumbnail on the right. You can modify both the color of the band and the thumbnail 
if you go to Options→Settings and select Schedule Manager\View:  

 
Double click on any item of the Available columns list to open a color 
palette and choose the color you prefer. 
 
Select an item and use the […] button under the list to browse your system 
and choose the Image file that you want to use as the thumbnail. 
 
Click Presets if you want to restore the default values. 

 
 
 
 
 
 

 
 

AIRED EVENT AND NEXT ONE 
 

 
You can skip the aired event and play the next one (step 2) by simply clicking the Play Next button. 

 
You can stop the aired event by clicking the Stop button or pressing the Pause key on the keyboard. 

 
 
When you stop the aired event, OnAir does not play any audio and sets the transmission mode to Manual. Click the 
Play Next button to manually play the next item; click the Automatic button or press the spacebar on the keyboard 
to set OnAir back to automatically play the items of the playlist. 
 
 

CHANGING THE POSITION OF AN EVENT INTO THE PLAYLIST 
 
If you want to move an event into a different position of the playlist, drag it to the new position. The item in the 
original position and the following playlist will move one step down. You can disable this option from the OnAir 
Setup. 
 
 

REMOVING AN EVENT 
 

 

To delete an event from the playlist, simply click on the button on its left, that will immediately remove it and move one 

step up all the events below; you cannot remove the aired event, but you can go to the next one by pressing the play 

button. 

 
 

ADDING AN EVENT 
 

 

To add a new event in the playlist, click on the button on the right: a selection mask with all the available audio categories 

appears (see the section MENU FOR THE CHOICE OF AN EVENT), and the chosen audio is inserted in the position where 

you pressed the inserting button, moving one step down all the events below. 

 
 
You can insert and play external audio files, not belonging to the Library, by opening a folder in Windows and moving 
a file into the playlist with drag-and drop. This option can be disabled from OnAir Setup. 
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7.2.B COUNTERS 

 
The situation of the aired event is shown in the time panel just below it; an example of the time panel is shown in 
the figure below: 
 

 

Intro 
It is the time in which the DJ can talk on the air without overlapping the words of the song that 

is starting (the background color turns orange when there are three seconds left) 

Count Up elapsed time of the event 

Count Down remaining time to the end of the event (the end is defined by the Mark Out point) 

Post Mark Out difference given by the real length of the event and the mark out 

 
 
Note: The Mark Out is the point where the mixout of the aired event begins and OnAir starts playing the next event; 
this value can be equal to or less than the real duration of the audio file. 
 
The same information of the counters is reported, in a graphic view, into OnAir main panel on the right, together 
with the clock and the Country name (this value is automatically detected by Windows Regional settings, but it can 
be modified in the OnAir Setup). 
 

7.2.C PLAYOUT MODE 
 

When you start OnAir, the Automatic mode is set for both scheduling and advertising (unless otherwise 
specified). 
In Automatic mode the events are played consecutively, and when the playlist is empty the program 
loads new events by choosing them according to the schedule (see the SCHEDULING Chapter). 

 

 

When OnAir is in Manual mode, you must click Play Next to start each event. 
You can switch from Automatic to Manual mode by pressing the spacebar on the keyboard. When 
you switch from Manual to Automatic mode, if there is nothing on the air, ONAIR starts broadcasting 
the events from step 2. 

 

7.2.D VUMETERS 
 
The VuMeters displayed in the upper right corner show the original output level of the audio file currently played by 
ONAIR.  
 
If you do not want to display the VuMeters, you must enable the Hide the VuMeters parameter in the ONAIR Setup. 
 
 

7.2.E UPDATING PARAMETERS 
 

 

You must press the UPDATE button to let OnAir know about some changes in the settings, to update it about any changes 
in the Songs data or in the Traffic schedule of the day. 

 
During the update, the button displays a small progress bar; the update function is disabled if a Traffic cluster is 
ready (TRAFFIC panel turns YELLOW) or is being played. 
 
NOTE: use the UPDATE function only if truly necessary. 
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7.2.F TRAFFIC 
 
By default, OnAir automatically plays a Traffic cluster when its schedule time arrives, but only after the currently 
airing item has finished. If you want to run a Traffic cluster at a predefined time, you can insert it into the playlist in 
two ways: 
 
- manually: insert a new event, click the Traffic button and choose an advertising cluster 
- automatically: through scheduling (Events Schedule, Manual Schedule, DIGIWARE schedule). 
 
Even when using the second way, the TRAFFIC panel displays the schedule time of the next Traffic cluster. 
 

 
By clicking on the [ADV] button, the following mask will appear on the right side of the screen. 

 
The info on top show the schedule time of the next cluster, its duration (in case of 
splitting areas, it shows the duration of the longest one), and the countdown to the 
scheduled time. 

 
 
 
 
 
 
 
 
 

 

 

Pressing the related button, the cue mask for the advertising appears. 

 
 

 
Two buttons are shown above the red timer: 
 

 

Automatic 
Traffic will be played at the scheduled time after the end of the aired event 
(unless specific parameters that are described in the Traffic settings). 

 
Manual 

It is up to the operator to confirm the broadcasting of each cluster by clicking on 
the Play button in the Traffic mask, which will activate at the scheduled time. 

 
The duration and description of each commercial composing the cluster are displayed in the ADV box. 
 
 
 

WARNING: If you change the audio or the composition of a cluster in the current day, you need to press the UPDATE 
button to notify OnAir of the changes. If you changed the audio or the composition of the cluster that is already 
loaded in the TRAFFIC panel, you must also double-click on the value that shows the next schedule time. 
If you happen to change the Traffic schedule of the day often, you can enable some parameters in the Traffic setup 
which allows OnAir to automatically update when the Traffic schedule changes. 
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7.2.G SCHEDULE SELECTION 

 
OnAir loads the playlist according to the generated schedule and the setup parameters, refer to the Scheduling 
chapter for information on the different ways of creating and editing the schedule. 
You can manually load any daily schedule in the playlist via the [SCHED] button. 
 

 
You can select a schedule by pressing the [SCHED] button, a mask appears on the right side of the screen:  

 
 

 
 
In the Day box, there is a list of the dates containing at least a daily schedule. Selecting one of these dates, the hour 
points of the related schedule will be displayed on the Hour box. 
 

 

Choosing a time, the related schedule will appear in the box below. Click the button to insert this schedule on top of the 
playlist or close the panel to return to the main screen and cancel the insertion. 

 
If you double-click on a schedule line, the item will be inserted in the playlist together with the previous one and the 
following one. 
 
OnAir can also read the daily schedules generated by DIGIWARE or by other third-party softwares, such as Selector 
and Music Master. 
Note: If you want OnAir to play the schedule generated by DIGIWARE, you must activate Enable Digiware Mode 
parameter in the OnAir setup (see related chapter). 
In this mode you can load a daily schedule in the playlist, just select a day from the following mask: 
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REPLACE: replaces the current playlist with the selected schedule (only the steps following the current time will be 
loaded). 

 
INSERT: inserts the selected schedule in the playlist, starting from the first position and moving down the steps 
previously loaded (only the steps following the current time will be loaded). 

 
APPEND: appends the selected schedule to the steps previously loaded (only the steps following the current time will 
be loaded). 

 
 
The [SCHED] button turns green during the REPLACE, INSERT and APPEND operations of the schedule. If you use the 
DIGIWARE schedule, at every new schedule update, OnAir automatically refreshes the playlist and the [SCHED] 
button turns green to tell the operator that an update is in progress. 
 

 
Select a day and click this button to display all the scheduled items: 
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If you double-click on an item, the program will insert it in the playlist’s first position. 
 
Note: the daily schedule generated by DIGIWARE will be automatically loaded into the playlist 10 minutes before 
midnight. 
 
 

SELECTION OF EVENTS AND SEQUENCES 
 
In the OnAir Setup, you can set Elements to be shown when clicking the SCHED button to show the Events Schedule 
and the Clocks using the [SCHED] button. The possible options are: 
1 - The SEQUENCE voice appears in the DAY box; if you select it, the list of available Clocks appears in the TIME box; 
you can directly insert a Clock into the playlist by selecting it and clicking the Confirm button. 
2- The weekdays of the Events Schedule appear in the DAY box; select one day to display the related time points in 
the TIME box; you can directly insert a time point into the playlist by selecting it and clicking the Confirm button. 
3 - Both the SEQUENCE voice and the weekdays appear in the DAY box. 
 

 
 

7.2.H EMERGENCY KEYS 
 
The Emergency Keys are three commands that have been designed to forcibly stop the playback of some special 
events, such as Traffic clusters, which cannot be stopped using the Stop function. 
 
With the activation of one of the Emergency Keys, OnAir stops the aired event and sets the play mode to Manual. 
 
By default, you can activate the Emergency Keys using a key combination when OnAir window is active: 
simultaneously press the [Alt] and [1] keys to activate the first emergency key; simultaneously press the [Alt] and [2] 
keys to activate the second emergency key; simultaneously press the [Alt] and [3] keys to activate the third 
emergency key. 
 
If you want to associate an audio to the Emergency Keys, use the Hot Keys tool in Administrator Tools section (see 
related chapter). 
 

 

Press the Play Next button to resume the scheduling and play the next step, then you can switch back to Automatic 
mode. You cannot switch back to Automatic mode if you did not use the Play Next button first. 

 
You can display the three Emergency Keys buttons under the playlist section, by enabling Display the Emergency 
buttons parameter in the On-Air\Main Settings 2 section of the ONAIR Setup. 
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7.2.I MENU FOR THE SELECTION OF AN EVENT 
 

 
Click on this button to insert a new item into the playlist, the selection menu opens: 

 

 
 
 
The voices displayed in the top half of the menu are default, they cannot be modified. The voices in the bottom half 
of the menu can be customized according to the user you access with when opening the OnAir playout. 
By clicking the buttons from 1 to 8, other selection pages appear (you can manage them from the Audio Manager 
section in the main setup). 
 
Click on one of the voices to open the related table of the Library; double-click on a line of the table to add it into 
the playlist, in the position where you clicked the [+] button or drag&drop the item into the playlist to insert it in 
one of the visible positions. 
 
The insertion method just described does not apply with the following categories: 
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TIME SIGNAL 
Click the [Time Signal] button to directly insert the Time Signal event into the playlist. When the time comes to play 
the Time Signal, OnAir will read the PC time and automatically select the relevant hour and minute audio files. See 
the Time Signal paragraph to know how to set the base of the time signal, the hours and minutes. 
 

TRAFFIC 
Click the [Traffic] button, the daily list of the advertising clusters appears. Double-click on a time point to insert the 
cluster into the playlist. 

WARNING: if the daily list is empty, it means OnAir is not finding the Traffic schedule of the day. 

 

7.2.J CUE 
 

 

You can cue any audio included in the playlist by pressing the button on the right side of the related event, and the 
following mask appears: 

 

 
 
 

MARKERS 
 

 
The Play button starts the cue of the selected audio. 

 

 
The Stop button stops the cue. 

 

 

Use the "forward" and "backward" buttons to move ten seconds into the cueing. 
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move +/- 1 second, +/- 1 tenth of a second, +/- 1 hundredth of a 
second, or place to the beginning or end of the track 

 

 
This button sets the starting point (Mark In) of the audio. 

 

 
This button sets the Mark Out point of the audio 

 
The settings of Mark In and Mark Out for the selected audio are temporary and do not affect the 
original values saved in the Library, they will be erased after the audio will be played 

 

 

With this button, you can listen to the end of the previous step and the beginning of the cue (mix in). By default, 
you hear one second before and one second after the Mark In; if it is not enough, you can increase the listening 
period up to 60 seconds with the Prelisten time for the mix parameter in the On-Air\Audio\Mix section of the 
ONAIR Setup. 

 

 

Click this button to listen to the mix between the selected item and the beginning of the following item (mix out). 
The fader next to the waveform changes the MIXOUT value of the selected item, so you can change the mix out 
with ease, also thanks to the visualization of the graph in the MIX section. As for the Mark In, by default, you hear 
one second before and one second after the Mark Out, unless you change the value of the Prelisten time for the 
mix parameter in the On-Air\Audio\Mix section of the ONAIR Setup. 

 
 

MIX 

 
 
Under the MARKERS sections, you find a multi-track view with the graph of the selected item and the first part of 
the next item in the playlist. If you do not see the waveform into the view, click on it and use the REDRAW button 
on the right to generate the waveform. 
If you move the mouse on one of the marking points, the mouse pointer turns into a small hand and you can 
drag&drop the marking points in a new position. 
 
The CUE button is also active for News Bulletins (you can prelisten only the first story) and Traffic (you can prelisten 
only the first commercial of the first area. The CUE button is not active for the Time Signal. 
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7.2.K HOT KEYS 
 

 
Press [HOT KEYS 1/2] or [HOT KEYS 3/4] to display the following keyboards on the right of the screen: 

 

 

 
You can define a series of pages made of IDs, bases or loops etc. Each page can contain 20 keys. The default available 
pages are 100, but if you need a larger number of pages, you can change it in the main settings. 
 
Click an item to play it. Hot Keys can play once or in a loop. Keys with looped audio are indicated with an icon on the 
left. The time to the end of the audio is indicated in the related counters: 
 

  and   
 

 

To manually stop the play of an audio, click the Stop button to the left or right, according to the page the audio belongs 
to. 

 

 

To change the current page, click one of the related buttons, the one on the left for the left keyboard (white), the one 
on the right the right keyboard (yellow). The list of all the available pages appears: 
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You can select a page by double clicking on it or by selecting it and pressing the Confirm button.  
 
When you run OnAir, it loads page 001 to the left and page 002 to the right, so it may be convenient to associate the 
most used audio to these two pages. To modify the content of these pages, use the Hot Keys tool in Administrator 
Tools section (see related chapter). OnAir automatically updates the content of the pages each time they are loaded. 
 

 SCHEDULING RULES 
 
When in Automatic mode, OnAir reads the schedule at the beginning of each minute and loads the events into the 
playlist at their scheduled time. 
The priority of the types of scheduling is so ordered, from highest to lowest: 
 
- Events Schedule and Manual Schedule 
- Rolling Clock. 
 
OnAir loads the Events Schedule and Manual Schedule only at the scheduled day and time and typically inserts their 
items on top of the playlist. 
OnAir loads the Rolling Clock every time the playlist is empty; OnAir always uses the content of the last time point 
encountered based on the current day and time, until the next scheduled time point. 
 
The most frequent request in the various schedulings is the selection of songs by Rotation Category. Every time 
OnAir automatically loads a song by Rotation Category, it makes a calculation based on some parameters that are 
set in the On-Air\Scheduling\Automatic song selection section of the OnAir Setup: 
 

• Artist repetition time 

• Max number of songs in the selection queue 

• Max number of songs in the first selection queue 

• Percentage of songs in the selection queue 

• Percentage of songs in the first selection queue 
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WARNING: Percentage of songs in the first selection queue and Percentage of songs in the selection queue, if set, 
have the priority on Max number of songs in the selection queue and Max number of songs in the first selection 
queue. 

 
How these parameters work during the song selection: 
1)  All the songs of the scheduled Rotation Category are ordered according to the last time they were broadcast. 
2)  The first [Max number / Percentage of songs in the first selection queue] songs are taken, discarding those which 

Artist has been broadcast less than the time set in [Artist repetition time]. 
3)  One at random is chosen among the remaining songs. 
4)  If no songs remained, the choice is repeated among the first [Max number / Percentage of songs in the selection 

queue] songs. 
5)  If the Artist’s check fails for all the songs also in this occasion, the program selects the song of the scheduled 

Rotation Category which has been broadcast longer, without checking the author’s repetition. 
 
Each user can customize all the parameters described above according to their needs. 
 
To avoid frequent repetition of the artists, it is appropriate to set a schedule by Rotation Category only if there are 
at least [Max number / Percentage of songs in the selection queue] songs of that category, but also with a different 
number of Artists. 
 
N.B.: The selection of IDs, bases, stingers, voice overs and programs by Rotation Category usually occurs randomly 
and with no regard to repetitions. 
 

 DIGIWARE SCHEDULE 
 
Only if using the schedule made by DIGIWARE, OnAir can perform the following functions: 
- broadcast an event (and following ones) only after a certain time. 
- broadcast an event within a certain time. 
- broadcast all the events of a group (without deleting the ones that exceed the time limit). 
 
 

INITIAL SETTINGS 
 
The main parameters for the management of Digiware schedule in OnAir are set in On-Air\Scheduling\Digiware 1 
section of the OnAir Setup: 
- OnAir uses the daily schedule produced by DIGIWARE only if you set the Enable Digiware mode parameter. 
- The folder where DIGIWARE schedules are exported must be specified in the Playlist text file path parameter. 
 
When Digiware mode is enabled, the list of schedules created with DIGIWARE appears by clicking the [SCHED] 
button. 
 
We recommend setting Display only the number of playlist shown by assigning a value from 1 to 9, which indicates 
how many exported daily schedules to show before and after the current day. 
 
 

LOADING THE SCHEDULE 
 
By default, Digiware schedule is loaded in the playlist: 
- at OnAir’s start 
- at every new data send from Digiware 
- at 10 minutes to midnight of each new day 
- when clicking the UPDATE button. 
 
You can disable all the automatic loading systems by setting the Disable the loading of the playlist parameter: by 
doing so you can manually load Digiware schedule only by the [SCHED] button. 
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The schedule of the new day is appended into the playlist 10 minutes before midnight, both for not overloading 
OnAir’s work at midnight and for starting the new schedule on time. 
 
When you run OnAir, the schedule is automatically loaded from the first event that has the scheduled time greater 
than the current time. If you prefer that the schedule is loaded from the first event greater than or equal to the 
BEGIN of the current hour, just enable the Load the playlist from the On-Air start time parameter (eg: if you run 
OnAir at 16:18, it will load the schedule starting from 16:00). 
 
When OnAir realizes that today's schedule has been changed, or when you press the UPDATE button, the playlist is 
reloaded starting from the first event that has time greater than the current time, avoiding to modify the first steps 
and the following steps if they belong to the same group of the first ones. This number of steps is set with the Number 
of events to update after parameter; if it is set to 0, OnAir considers it as 2 by default. 
 
Example: if you press the UPDATE button at 07:01:30 and the schedule includes 
 
07:00:00 SONG 1 
07:04:30 STARTING STINGER 
07:04:50 PROGRAM LINKED TO PREVIOUS 
07:10:00 ENDING STINGER LINKED TO PREVIOUS 
07:10:10 SONG 2 
 
The first step that OnAir would modify in the playlist is STARTING STINGER, but since Number of events to update 
after is 2, it will keep both STARTING STINGER and PROGRAM and, since ENDING STINGER too is linked to PROGRAM, 
it will start reloading the playlist from SONG 2. 
 
Generally, OnAir checks every 40 seconds if the daily schedule has been exported again: when it happens, if OnAir is 
in Manual mode, the update of the playlist takes effect immediately; if OnAir is in Automatic mode, the update takes 
effect as soon as there is an audio with a length greater than 60 seconds, 30 seconds have already been played and 
more than 30 seconds are to the end. You can disable this automatic update feature by setting the Disable the 
automatic update of the playlist parameter: doing so, you can update the daily schedule only through the UPDATE 
and [SCHED] buttons. 
 
Note: if you have set a special OnAir configuration with the VOICE TRACK’s record option enabled ([VT] button), the 
daily schedule is not loaded both at OnAir’s startup and at each new data export. When you record the VOICE TRACKS 
of the current day schedule using this VT OnAir, the Main OnAir receives the modifications as soon as you close the 
VT OnAir or after the number of seconds set in Maximum waiting time for the INV files, since the last change made 
to the voice track. 
 
 

TEMPORALLY LOCKED EVENTS 
 
In Digiware schedule, you can set events that are locked to a certain hour, which means OnAir cannot start them 
before a minimum time (Min Hour) or will try to start them before a maximum time (Max Hour). 
 
When OnAir is in Automatic mode, if in position 2 of the playlist there is a locked event with Min. Hour set, and the 
item on the air will end at a time before Min Hour, OnAir will use the Rolling Clock schedule to automatically add in 
position 2 one item at a time play it until the Min Hour is reached (for this reason it is important that a Rolling Clock 
schedule is always set). 
 
If you want to give a few seconds of tolerance to the locked events, i.e. you want OnAir to advance their start when 
the end of the airing item is next to Min Hour, you can set the Seconds of tolerance for the addition of songs 
parameter which prevents OnAir to insert a song if there is less than the seconds set to arrive to Min Hour. 
 
If OnAir is in Automatic mode and a locked event with Max Hour is in the playlist and if its expected Air Time is higher 
than the Max Hour, the necessary erasable events between position 2 and the position occupied by the locked event 
will be removed and all the necessary interruptible events will be interrupted (by moving the mark out to OUTTRO), 
thus to start the locked event before the Max Hour.  
In the above cases, the events belonging to the same group as the aired one are never deleted, even if they are 
erasable, but are interrupted if they are interruptible. 
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The erasable and interruptible events are removed and interrupted only in the presence of locked events. 
 
If for any reason a locked event with Min Hour and Max Hour is deleted from the playlist before the Min Hour, the 
next item in the playlist will inherit the same options (if it is not already locked). This is to maintain the lock even if 
the locked event's audio is missing, or if the locked event is a note that is automatically deleted by OnAir. 
 
Note: if ONAIR has the VT option active, the locked events are managed as if they were not locked. 
 
 

DIGIWARE AND XRADIO SCHEDULE 
 
You can use at the same time both the DIGIWARE schedule and XRadio’s Events and Manual Schedules, that will mix 
according to the scheduled times. 
If you want to disable the Events Schedule, disable the Enable Events Schedule parameter in the On-
Air\Scheduling\Advanced 1 section. 
If you want to disable the Manual Schedule, set the Manual scheduling loading mode parameter to 0 – Manual. 
 

 THE NEWS BULLETINS 
 
The newscasts are aired by following these steps: 
 
- starting tune; 
- musical background (repeated until the end of the News Bulletin) with the volume level set from the SETUP; 
- news are played over the musical background; 
- at the end of the news, the ending tune is played. 
 

 THE TIME SIGNAL 
 
The Time Signal, generally, is broadcast in this way: 
 
- The base starts playing (note: the base is not played in a loop, so it must be long enough to include the reading of 
the hours and minutes). 
- After the time specified in Voice Starting (refer to Audio Manager\Time signal settings) the reading of the hours 
and minutes starts and, at the same time, the volume level of the base is lowered. 
- At the end of the time reading, the volume level of the base rises and it is played to the Mark Out point. 
 

 VOICE OVERS 
 
Voice Overs are audio that overlap two audio tracks with the intention to finish at the end of the intro of the second 
track (for example, they are used to simulate the presence of a speaker on the air) to do this, OnAir plays the Voice 
Over when the time to the end of the event on the air, added to the intro of the next event, is equal to the lenght of 
the voice over. 
 
Refer to Voice Overs chapter for more info. 
 
OnAir automatically deletes the Voice Overs lasting less than half a second from the playlist. 
 

 RECORDING 
 
If you have set an audio card for recording, in OnAir you can use the REC panel to record some audio and retransmit 
it. 
Recording can be done on a separate audio file, or directly on XRadio’s tables, such as Programs, Bases, IDs… etc. 
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Click on the [REC] button to open the recording panel. 
The screen shows the following mask: 

 

 
 
By default, clicking the folder icon the list of Programs appears and you can choose the audio you want to record. If, 
through the OnAir Setup, you have set more than one table where to choose the item to record, you must right-click 
on the folder icon to switch the selected table; when you see the name of the desired table, click with the left mouse 
button to display the list. 
If you press the record button, and the audio input does not reach the VOX threshold, the panel and the REC button 
turn YELLOW, and when OnAir starts recording they turn RED. 
To set the recording parameters, refer to the On-Air\Recording section of the ONAIR Setup manual. 
 
 

SCHEDULED RECORDING WITH REG- AND FIN- 
 
you can automate the recording, on a single audio file, of some passages played by OnAir (e.g.: recording on one 
audio file a sequence of events such as stinger, promo, News Bulletin… etc.). 
To do this, you need to prepare 3 different records in any audio category, who have for example the following 
descriptions and filenames: 
 

Description Filename 

REC START REG-M:\RADIOX\AUDIO\PROGRAMM\EDITION.MP3 

REC STOP FIN- M:\RADIOX\AUDIO\PROGRAMM\EDITION.MP3 

EDITION M:\RADIOX\AUDIO\PROGRAMM\EDITION.MP3 

 
The audio with REC START as description will give OnAir the command to start the recording on the audio file named 
M:\RADIOG\AUDIO\PROGRAMM\EDITION.MP3. 
The audio with REC STOP as description will give ONAIR the command to stop the recording. 
The audio with EDITION as description will be the one that will contain the recorded audio. 
To automate the recording of three events in a single audio file, such as, for example 
 
STINGER 
PROMO 
NEWS BULLETIN 
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you must schedule: 
 
REC START 
STINGER 
PROMO 
NEWS BULLETIN 
REC STOP 
 
When OnAir will find the REC START event in position 1 of the playlist, it will skip the event and the recording will 
start on M:\RADIOG\AUDIO\PROGRAMM\EDITION.MP3; it will play the STINGER, followed by the PROMO and then 
the NEWS BULLETIN; when it will find the REC STOP event, it will skip the event and stop the recording. 
 
Note: the automatic recording procedure works well if OnAir is in Automatic mode. 
 

 CLOSING THE PROGRAM 
 
If you want to close OnAir, click the X button on the top right of the window. The following message appears: 
 

Click [OK] to definitively exit the program. 
 
Click [CANCEL] to keep it open. 

 
 
 
 
 

 

Warning: if you close the program, OnAir does not broadcast any audio until you run it again. 

 

   KEYBOARD SHORTCUTS 
 
OnAir can be supplied with a pre-configured keyboard with the main commands to operate on its interface. 
 
In case you don’t have one, you can use the PC keyboard: some keys are associated with special functions for OnAir, 
below you will find a detailed description. 
 
Alt-R: Reading of transmissions log 
Alt-R opens the NOTEPAD with today’s transmission log. 
 
Alt-L: Reading of advertising log 
Alt-L opens the NOTEPAD with today’s advertising log.  
Note: This log exists only if the Type parameter in the On-Air\Transmission Log\Transmission Log 1 section is set on 
“3 - .TXT .REG and .LOG logs”. 
 
Alt-T: Reading of DIGIWARE log 
Alt-T opens the NOTEPAD with today’s DIGIWARE log. The DIGIWARE log is much more detailed than the 
transmissions log, although harder to understand for the operator. 
 
Alt-D: Reading of DJL log 
Alt-D opens the NOTEPAD with today’s DJL log. This log contains information on the actions done on the interface 
by users during the functioning of OnAir (for example, switching from one mode to another, clicking the Stop button, 
clicking the UPDATE button… etc.) 
Note: This log exists only if the DJL parameter in the On-Air\Transmission Log\Transmission Log 1 section is different 
from 0 and if the Path parameter contains an existing folder. 
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WARNING: If the NOTEPAD opens with the message: “The file 15-05-10.txt is too long. Use another editor”, close 
the message and then the NOTEPAD. If any log is longer than expected, you can check the content by using another 
editor.  
It is strongly recommended not to open today's transmission log with MS WORD or another editor that will open 
the file in exclusive mode. 

 
[Spacebar]: Switching between Automatic and Manual mode 
Spacebar switches from Automatic to Manual mode and vice versa. 
 
[Enter]: Play of the event in position 2 
Pressing the Enter key, the event in position 2 is moved in position 1 and is broadcast. 
 
[Pause]: Stops broadcasting. 
Pause Stops broadcasting and switches to Manual mode. 

WARNING: This key cannot stop Traffic or News Bulletins. 

 
[Ins]: Advertising start 
Ins-0, Ctrl-Ins, Ctrl-0: any of these keys starts the Traffic if it is ready. 
 
Alt-1: Execution of Emergency keys 
The Emergency Keys interrupt the broadcast, switch to Manual mode and possibly play an audio (see Emergency 
Keys paragraph). 
 
ESC: Quick exit from the selection windows 
ESC closes some panels, such as CUE, Insert and SCHED. 
 
Scrolling the steps in the playlist 
[-] or Page Up or Arrow Up: moves a step up. 
[+] or Page Down or : moves a step down. 
[*] or Ctrl-Page Down or Ctrl- Arrow Down:moves to last step. 
[/] or Ctrl-Page Up or Ctrl-Arrow Up: moves first step. 
 
 
HOT KEYS 
 
Left keyboard 
F1 plays the content of the first key 
… 
F12 plays the content of the twelfth key 
Shift-F1 plays the content of the thirteenth key 
… 
Shift-F8 plays the content of the twentieth key 
Home displays the list for selecting the page to load. 
Del stops the audio currently playing. 
Ctrl-A switches to next page 
Ctrl-S switches to previous page 
Ctrl-Enter repeats the last played audio 
 
Right keyboard 
Ctrl-F1 plays the content of the first key 
… 
Ctrl-F12 plays the content of the twelfth key 
Ctrl-Shift-F1 plays the content of the thirteenth key 
… 
Ctrl-Shift-F8 plays the content of the twentieth key 
Ctrl-Home displays the list for selecting the page to load. 
Ctrl-Del stops the audio currently playing. 
Ctrl-D switches to next page 
Ctrl-F switches to previous page 
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Ctrl-Shift-Enter repeats the last played audio 

ATTENTION: to use the keyboard shortcuts, the OnAir window must be active and in the foreground 

 
 

 ADVANCED FEATURES 
 

7.11.A MONITOR AND INPUT RETRANSMISSION 
 
If you have an available audio input in the OnAir machine, in addition to recording, you can also display and 
retransmit an external audio source that you are ingesting to that input. 
There are two different modes of functioning according to the Mode parameter in the On-Air\Audio\Monitor section: 
 

 

- STANDARD (default): pressing CTRL+SHIFT+left mouse button on [MON] stops OnAir playlist broadcast, 
switches to Manual mode and the audio input is played; pressing ALT+SHIFT+left mouse button on [MON] 
again restores the OnAir playlist broadcast and switches to Automatic mode; the audio input is constantly 
monitored, if it goes below the value set in Silence Volume (dB), in the On-Air\Audio\Monitor section, for more 
than a period set in Max Silence Time (s), OnAir switches to Automatic mode. 

 

 

- ACTIVE WITH VOLUME ATTENUATION: clicking with the left mouse button on [MON+] enables the reading of 
the audio input level, if OnAir is in Manual mode, the audio input is broadcast; then, clicking with the right 
mouse button on [MON+] stops the audio broadcasting and leaves OnAir in Manual mode. 
ATTENTION: clicking [MON+] when OnAir is playing will overlay the external audio onto the playout audio 
 
- ACTIVE WITH EXTERNAL COMMAND ON: clicking with the left mouse button on [MON+] stops OnAir playlist 
broadcast, switches to Manual mode and the audio input is played. Clicking with the right mouse button on 
[MON+] stops the audio broadcasting and leaves OnAir in Manual mode. 

 

 
For further details about the options and settings of the MONITOR, refer to the related sections of the ONAIR SETUP. 
 

7.11.B EXCLUDED SONGS AND AUDIO 
 
In the Songs table you can specify that a song has the "Excluded" attribute. By default, OnAir can select the excluded 
songs when using a schedule by Rotation Category, except if, in On-Air\\cheduling\Automatic song selection section, 
you activate the Disable Songs parameter. 
Also, in the Insertion panel, the excluded songs do not appear in the Songs table unless you select the Ecluded button 
that you find in the toolbar. 
 
The Excluded option is also available for the other audio tables, in which case the parameter you must activate for 
not using them in the selections by Rotation Category is Disable Jingle. 
 

7.11.C VOLUME SLIDER 
 
Usually, you can manage the audio level of the broadcast by the audio panel of the sound card you are using in the 
OnAir PC and, most of all, by the audio mixer that is receiving the OnAir outputs. 
In case you are not provided with an audio mixer, you can display the volume slider of the aired event by clicking on 
the [VOLUME] button. You must activate this function by setting the Display Master parameter in the On-
Air\Audio\Volumes section of the ONAIR Setup: 

4) Display: the audio level change affects the aired event only, OnAir restores the default value (maximum volume) 
when the next event starts 

5) Display and keep the same volume level: the audio level change affects all the events on the air 
 

The volume change has no effect on Traffic, News Bulletins and Voice Overs. 
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7.11.D SOCIAL MEDIA MESSAGES 
 
OnAir allows you to view and manage the social media message received by Axel Technology’s SocialHub. 
If you want to activate the messages panel, you must set the path of the folder where the messages are saved, in 
the Recording path field in the On-Air\Communication\SMS section. For further details about the parameters for this 
function, refer to Setup ONAIR Manager chapter. 
 

 

Setting the messages reading function, the [SOCIAL] button is enabled, and it turns yellow when a new message 
is received. 

 
Clicking the [SOCIAL] button, the following box appears: 
 

 
 

 
 
 

Double-clicking on a line, or on the related checkbox, you mark a message as "read"; it turns gray and will 
disappear from the list at the next messages update.  
 
To immediately cancel a message, double-click on the red X button. 



 
    

 
82 ONAIR |Auto/Man Mode For Schedule 

 

XRadio· User Manual · ENG 

 

 
 

 

 

 

To read the received messages instantly, press the button with the arrow icon; if you want to close this window, 
press ESC on the keyboard or use the X button on the top right. 

 

7.11.E AUTO/MAN MODE FOR SCHEDULE 
 
If you wish to use the manual loading of the schedule at some times of the day and, at some other times,.its 
automatic loading, you can enable the Playlist loading mode parameter in the On-Air\Scheduling\Advanced 1 
section, which has the following function: 
 
6) Do not display buttons (default): the daily schedule is loaded as usual, according to the parameters set in the 

ONAIR Setup 
7) Display and activate the AUTOMATIC loading: when starting ONAIR shows, next to the VuMeters, the AUTO 

SCHED. \ MAN. SCHED switcher, and AUTO SCHED is enabled. 
8) Display and activate the MANUAL loading: when starting, ONAIR shows the AUTO SCHED. \ MAN. SCHED switcher, 

and MAN. SCHED is enabled. 
 
When MAN. SCHED. is enabled, the daily schedule can be loaded only by the user in the playlist; when AUTO SCHED. 
is enabled, the daily schedule is loaded according to the parameters set in the ONAIR Setup. 
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 ONAIR SETTINGS 
 

When you first install XRadio, you are provided with a Main OnAir playout ready to broadcast, but you can create 

and manage different types of OnAir, each with a different purpose. 

You can have an Emergency OnAir that works in parallel with the Main OnAir from another workstation, or a REC 

OnAir that you can run on an Edit workstation, with which you can test the playback of a scheduled program and 

record some audio. 

 

To create the various OnAir configurations, launch the Setup ON-AIR Manager application from the OnAir 

Accessories section in the Tools menu. 

 

 
 

In the main window, you find the list of the available OnAi instances. When you install XRadio you will find only the 

Main OnAir configuration. 

If you click on a voice of the list, below the box you can see the path and name of the related configuration file. 

 

If you want to create a new OnAir configuration, select a voice from the menu and click on Copy Setup: a window 

opens, where must insert a file Name (max. 8 characters) and a Description for the new configuration (e.g.: 

Emergency OnAir). 

This will create an exact copy of the original configuration, then you must open it and change it according to your 

needs. 

 

Double click on a voice of the list or select it and click on Open Setup to open the settings panel. 

 

To associate an OnAir instance to one or more XRadio users, you must open User Manager from Administrator 

Tools, select a user, open its Permissions window, expand the OnAir voice in the tree menu and select the desired 

OnAir instance. 
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8.   ADMINISTRATOR TOOLS 

 

Administrator Tools contains a set of utilities that can help you to manage XRadio system. 

 

 USER MANAGER 
 

User Manager is the tool for managing the rights of each XRadio user and defining the applications that can be open 

for the Tools menu. 

 

Click User Manager from the Tool menu to open the User Manager window: 

 

When you install XRadio, the only available user 

is ADMIN, with full rights, no password. 

 

Double click on the ADMIN item or use the 

Modify button to assign a new password to the 

ADMIN user. 

 

 

 

 

 

 

 

 

 

 

Click the Insert button to add a new user: 

 

Write a Username (eg: edit) and, if you want, assign a Password to the new user. 

 

Click OK to confirm. 
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Now the edit user has been added to the Users list: 

 

When you select a User from the list: 

 

Click Modify if you want to change its Password. 

 

Click Delete if you want to delete the user. 

 

Click Duplicate if you want to create a new user 

by copying the settings of the selected one. 

 

 

 

 

 

 

 

You can associate the access to XRadio with each Windows User: you must create new users in XRadio, each one 

with the same name as a Windows User. In this way, every time you access Windows with a specific user and run 

XRadio, the program will open directly without asking for username and password. 

If you want all Xradio users to always insert username and password at the program access, you must go to 

Options→Settings from the Menu bar, select Common\Settings 2 and activate Do not allow Windows username in 

Settings 2. 

 

8.1.A PERMISSIONS 
 

Select a user from the list and click Edit permissions: 

 

The checked voices on the tree menu are the 

available program sections for the selected user. 

If you expand a voice of the menu, you will see 

the list of the applications belonging to that 

section. 

 

You can enable/disable sections or individual 

applications for each user simply by 

selecting/deselecting the related voices in the 

menu. 
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If you expand a voice of the menu and select an item, the window on the right will show the related parameters: 

 

Click the icon of each parameter to 

enable/disable it. 

 

For each user you can decide if they can 

Delete/Insert/Modify the items into each table, 

or which audio tables they can work on, and so 

on. 

 

 

 

 

 

 

 

 

 

The last parameter of each list is usually the Permission level that has four available options: 

None – All the functions are disabled; the user cannot run the application from the Tools Menu. 

Admin – User has the administrator rights on the application. 

User – User can operate on the application but cannot access and modify its settings. 

Guest – User can only browse the table contents and listen to the audio, but cannot do any changes. 

 

 

8.1.B ONAIR RUN AT WINDOWS STARTUP 
 

You may need to run OnAir automatically at every Windows startup. This function is useful if you have, for example, 

a power failure during the night and no one is on the Radio; OnAir automatically runs when power returns, if the 

OnAir PC and the Server have the automatic restart option enabled in the BIOS. 

 

HOW TO SET ONAIR AUTOMATIC RUN AT WINDOWS STARTUP 

 

9)  In User Settings, create a new User (e.g: ONAIR)  

10)  In the Permissions select ON-AIR voice from the tree menu and enable the RunAtStartup parameter 

 

You created a new user that will automatically run the OnAir playout every time you access XRadio with it. 

 

11)  Make a copy of the XRadio link that you have on your desktop and rename it (eg: Main OnAir) 

12) In the link Properties, in the Destination field add M:\RADIOX\BIN\WINDOWS\ ONAIR and save the changes. 

RADIOX is the folder where you installed XRadio Server, and ONAIR is the user you previously created that can 

run OnAir automatically. 

Now the string in the Destination field is: 

"C:\Program Files (x86)\DJPro\BIN.NETX\MediaLibraryLauncher.EXE" M:\RADIOX\BIN\WINDOWS\ ONAIR 

 

If you double click on the Main OnAir icon on the desktop, it will open XRadio with ONAIR user that will automatically 

run OnAir playout. 

 

13)  Finally, copy the Main OnAir link and paste it in: 

C:\Users\WindowsUser\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup 
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where WindowsUser is the user that is set to automatically access Windows at the PC startup. 

 

In this way, OnAir will automatically run at every Windows access. 

 

 HOT KEYS 
 

Here you create and prepare all the Hot Keys keyboards that you can use in the OnAir application. 

 

Select a voice from the Pages menu to display 

the Description and content of the related Hot 

Key. 

 

The Emergencies section displays the audio 

associated to the Emergency Keys (see related 

paragraph in OnAir Chapter). 

 

 

 

 

 

 

 

 

If you want to associate an audio to a button, click on it to open the Browser: 

 

Select one of the audio tables from the menu to display its 

content on the left and double-click on an item to associate it to 

the button. 

 

 

 

 

 

 

 

 

 

 

Alternatively, you can directly drag an item from a Library table to one of the Hot Key buttons. 

If you associate an audio to a button that already has an associated audio, the new one will replace it. 

 

Select the Loop option to the left of the button if you want to play the audio in a loop when you select it in OnAir 

(useful with backing tracks) 

 

Click the red X to the right of the button if you want to disassociate the audio 

 

  



 
    

 
88 ADMINISTRATOR TOOLS |AUDIO WITHOUT DATA 

 

XRadio· User Manual · ENG 

 
 

 AUDIO WITHOUT DATA 
 

In XRadio, when you delete any audio item from any table in the Library, you delete their metadata, but the related 

audio files are not deleted, so that you can recover them in case you made a mistake in deleting the item. 

However, in doing so, in the long term a quantity of audio files accumulate that are not linked to any data in your 

Library and are therefore unusable. 

The Audio Without Data function allows you to find these audio files so you can check them and possibly delete 

them permanently, so as to keep your data tidy and clean. 

 

 
 

Select the Radio station from the Stations menu, then in the Paths menu and in the Extensions menu select which 

audio categories audio formats you want to check. Finally, click on the icon with the magnifying glass to start the 

search. 

The results will appear in the box below. 

 

 
 

You can select one or more files from the list. The actions available for the selected files are: 

- Listen to the audio, using the play/stop tool you find at the bottom of the list. 
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- Recover the audio using the + button on the right of the window, which opens a dialog box where you can specifiy 

the Station and the Table (Archive) where to copy the selected file, assigning a Title/Description, an Artist and a 

Rotation Category to it. 

- Copy or move the file into a folder that you can specify (the tool will also create all the subfolders structure into 

the selected folder). 

- Permanently delete the selected audio files. 

- Print the complete list, and/or export it into a document. 

 

ATTENTION: if you schedule the Traffic using RamComm, don’t use this tool to delete the audio of the advertising, 

even if those files may be listed as unused. 

 

NOTE: deleted audio files cannot be recovered. 

 

 

 DATA WITHOUT AUDIO 
 

You can use Data Without Audio to verify the existence of the audio (file) for each item of each audio Table. 

 

 
 

Select one or more audio Tables from the Tables menu, then click on the magnifying glass icon to start the search. 

The result will appear in the two boxes below: 

- In the Files not found box the tool will show a list of items whose audio file is not present in the assigned path. 

- In the Files not specified box the tool will show a list of the items for which neither the name nor the file path are 

specified. This is an unusual situation, as XRadio automatically assigns path and file name to each item of an 

audio Table, so it is likely that this data has been manually deleted by a user. 

 

You can select one or more items into each list and you delete them, or you can print the whole list or save it into a 

document. 
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 KEYS MANAGER 
 

Keys Manager is a utility that allows you to associate a description to each dongle key on each computer. It facilitates 

the unique identification of each computer to allow you to trace the information when checking, for example, the 

transmission LOGs or OnAir operational LOGs. 

 

 
 

The main screen shows the list of keys in the format <keycode> - <Description1> - <Description2> - <Description3> 

where Description1 indicates, usually, the name of the computer. 

 

Usually, this list is automatically populated by XRadio which saves the data every time you open XRadio with a new 

key from a new PC, but you can modify this list at any time by adding a new item or deleting and modifying any item 

already present. Also, you can print the complete list or export it into a document. 

 

In the Insertion/Editing mask, you can click on the button on the right of the 

Insert new key box to automatically fill the data with the serial number of the 

key that is currently plugged in the PC you are working with. 

 

In the same way, the button on the right of the Description 1 (main) box allows 

you to automatically fill the data with the name of the PC you are working with. 
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 ARCHIVE MANAGER 
 

Archive Manager is an advanced tool, intended for use by system administrators, that allows you to open the 

content of any Table and run specific utilities.  

You must know the name of the Table assigned into SQL database in order to open the data you need: for example, 

the table’s name for the songs is CANFONTI. 

Click on Connect to  load the list of the available Tables in the related menu, then choose CANFONTI: the resulting 

table will show you, in one view, the whole content of the Song’s data. 

 

 
 

From this table, you can select one or more items and delete them, you can print the whole list or export it into a 

document. 

 

If you order the data by Description, and create a sub-order by Artist, then you can click on the tools button and use 

Find duplicates function to search for all the songs that have the same title and artist: in this way, you can delete the 

songs that you don’t want to keep because are doubled. When you want to disable/enable the last result of Find 

duplicates function, you must click on the last button on the right, called Show duplicated. 

 

Furthermore, the Recalculate Real Duration utility allows you to check the actual duration of the audio files 

associated with each item and update the Duration field in the Table. 

The Recalculate Introduction, Final and Context Duration utility works in the same way for the related audio. 

 

The Reset Last Passages utility deletes all the info related to the last passages of each song that are saved in the 

Songs Table: this action will affect XRadio’s schedule by Rotation Category, as all songs will be considered as never 

having aired. 

 

Append, Delete, Edit, End Edit, Cancel Edit. 
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 IMPORT WIZARD 
 

Import Wizard allows you to import audio with their metadata from one XRadio system to another. This tool is 

connected to the Export to folder (paragraph 3.3.C) and Export Wizard (next paragraph) tools. 

Run Import Wizard and click [Next>] 

 

Click [..] in Metadata import file/s to open the browser 

and select the DJProXMLExport.xml file previously 

generated by the Export tool, then click [Next>] 

 

 

 

 

 

 

 

 

 

 

 

Select the items you want to import from the list and 

click [Next>] 

 

 

 

 

 

 

 

 

 

 

 

 

Select the destination table in Import in menu and click 

[Next>] to start the import. 
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 EXPORT WIZARD 
 

Export Wizard is a tool that allows you to export the whole content of an audio table into a folder. All the metadata 

of the exported audio will be saved in DJProXMLExport.xml file into the same folder. 

Run Export Wizard and click [Next>] 

 

Select the tables you want to export and click [Next>]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click […] in Metadata Process path and select a folder 

where the tool must export the data, then click [Next>]. 

 

 

 

 

 

 

 

 

 

 

 

 

Click [Finish] to close the Wizard. 
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 LOG VIEWER 
 

Log Viewer is a simple tool that allows you to check the operations done by the software and the users, day by day. 

 

 
 

 

 AUDIO CARDS CONFIGURATION 
 

If you need to configure which local input and output devices you want to use in XRadio, you can run the Audio 

Cards configuration. 

 

Click [Add] in the PLAY/OUT or in the REC/IN section to 

insert a new device. 

If you want to delete a device, select it and click on 

[Remove]. 

Double click on an item to modify its parameters. 
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In the insertion/editing mask, open the Description 

menu to choose the device you want to use. 

The default Card type is “Multiformat”, it allows XRadio 

to import/play almost any different audio format, while 

“Windows DX” can manage only MPG, MP2, MP3 and 

WAV audio files. The other card types are related to old 

sound card models. 

Digital volume allows you to lower the device's audio 

level: this parameter can be useful when you are not 

using an audio mixer or when the sound card does not 

have its own control panel. 

 

The other parameters are automatically set by the 

software. 

 

 

 

In the main page, click [Next>] to move to the Settings for internal editor: 

 

Here you can set which output (Playing card) and input 

(Recording card) Xradio must use for its internal audio 

editor and player. The list in the menu is related to the 

outputs and inputs you have set in the previous page of 

the audio configurator. 

 

Once you selected the devices, you can set which audio 

format XRadio must use during the import and recording 

of a new audio. 

 

 

 

 

 

 

 

Click finish to close the configurator and save the changes. 

 

 

 SETTINGS 
 

Settings application collects and manages all the parameters and configurations of each application of XRadio 

system. You can run it also by Options in the Menu bar. 

 

Many of the settings you find in this configurator are related to specific situations or are the result of customizations 

requested by various customers over time. In this user guide we illustrated the most common and most useful 

functions that can be activated by any type of customer that is using the program. 
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9.   ADVANCED FEATURES 

 SERIES 
 

In most of the audio tables, you are provided with a function to create a series of items identified by a particular 

date or day of the week. Songs and Traffic tables are not provided with this function. 

 

9.1.A HOW TO CREATE A SERIES 
 

Click on the Create Series button in the Toolbar to create a Series in the selected table, or right click into the table 

and select Create Series from the context menu. The items of the series can then be programmed using their Rotation 

Category. XRadio, or Digiware, will choose the right file to be transmitted according to the scheduled day. 

 

There are two types of Series: Weekly or Monthly. 

 

WEEKLY SERIES 
by choosing the Weekly type, you can insert an event different for each day of the week. Select the days of the week 

for which you want to create an event; in the Category field, enter an identification code for the Series; in the 

Description field, enter the description that will identify the Series. Click OK to confirm and create as many items as 

the selected days. At this point you can import the audio into each item. 

 

Example: If you want to create the HOROSCOPE Series with a 

different file for each day of the week, you can enter HOROS 

(identification of Horoscope) in the Category field and 

HOROSCOPE in the Description field, by selecting all days of the 

week. 

 

 

 

 

Once you have confirmed with OK, the program will 
automatically create the related items, where the days of the 
week are indicated by MON for Monday, TUE for Tuesday, 
WED for Wednesday, THU for Thursday, FRI for Friday, SAT for 
Saturday and SUN for Sunday. 

 

MONTHLY SERIES 

By choosing the Monthly type you can create a different item for each day in a specific period. Enter the Start Date 

and the End Date in the related fields; in the Category field, enter an identification code for the Series; in the 

Description field, enter the description that will identify the Series. Click OK to confirm and create as many items as 

the days in the selected period. At this point you can import the audio into each item. 

 

Example: If you want to create the WEATHER Series with a 

different file for each day of the week, you can enter WEATHER 

(identification code) in the Category field and WEATHER in the 

Description field, setting 27/10/2023 as Start Date and 

31/10/2023 as End Date. 
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Once you have confirmed with OK, the program will 

automatically create the related items, where the date is 

expressed in YYYYMMDD format. 

 

 

 USER FIELDS 
 

User Fields are a series of 20 user-customizable fields associated to any audio table in the Library. They allow for 

better categorization of items in audio tables and can be used in advanced Scheduling (especially in Digiware) for a 

deep selection of the songs and events. 

 

To configure the User Fields for the Songs table, go to Options→Settings from the Menu bar and select Song 

Manager\User Fields. To configure the User Fields for the other audio categories, select Audio Manager\User Fields. 

 

In this paragraph we focus on Songs User Fields 

 

In the first box you have the list of the 20 User fields. The first three fields 

are already configured for the integration with the Visual Radio and for the 

SubGenre. 

 

In the middle, you can set up to three different User Fields to manage the 

additional artists, the multiple categories and the SubCategory. 

 

At the bottom, the three extra fields that manage the 

Introduction/Context/Final audio of the Extra data tab in the Songs table. 

 

 

 

9.2.A HOW TO INSERT A USER FIELD 
 

Select a free field into the list (eg.: Field4) and click Edit button to open the editing mask 

 

Write a Description for the new field (e.g.: Voice) an select an Insert Type in the 

drop-down menu. 

TextBox: simple text box 

TextBox with autocomplete: when you write in this box, the program suggests 

the data to insert based on those already entered previously in the same field 

Single-selection list: drop-down list where you can select only one item. 

Multiple-selection list: list where you can select more than one item. 

 

 

 

If you select TextBox or TextBox with autocomplete, you can click OK to confirm and exit. 

If you select Single-selection list or Multiple-selection list, you must insert the items into the list. 

For example, select Single-selection list and click the View button 
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Click the [+] button to add a new item 

Once you inserted all the needed items, you can set one of them as the Default value any 

time you will insert a new song. 

You can also associate a Tooltip to each item, by selecting it and writing in the related field 

Click OK to confirm. 

 

 

 

For example, insert Female, Male, Group and Instrumental in the Single-selection list and close the Settings by 

confirming all changes. 

 

When you open the editing mask of a song, in the User Fields tab you will find the new field:  

 

 
 

 

 COMMANDS AND SCRIPTS 
 

Commands is a special category of Xradio Library, where the user can create and manage a wide range of commands 

that can be sent by OnAir through RS-232, TCP/IP, UDP, HTTP or GPIO and used to remotely command other 

programs or devices. The commands, like any item of the other audio categories, can be scheduled or manually 

inserted into OnAir playlist. 

 

You can also manage some commands, called SCRIPTS, to make the OnAir itself (or a different OnAir that is running 

on another PC) execute specific actions. 

 

To create a new command, open the Commands 

table, insert a new item, write a Description and, 

in the File Name, write the command string. 
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In the following part of the document, we will explain how to write the command strings for each protocol and we 

will provide a list of the most used scripts. 

 

9.3.A RS-232 
 

By default, OnAir sends a RS-232 COMMAND through the COM port that has been previously set in the Split→Serial 

Port section of OnAir Setup. 

Command string is in text format. 

 

Example: XA1#/ 

 

If, on the other hand, you want to send particular characters, then use the syntax of the ASCII code for each character 

to be sent, where each number representing a character is enclosed in square brackets. 

 

Example: [240][2][6][50][52][247] 

 

NOTES: 

- OnAir keeps the COM port open for exclusive use until the program is open. 

- OnAir can open only one COM port. 

 

9.3.B TCP/IP 
 

A TCP/IP command string starts with the $ character. 

By default, OnAir sends the command to the IP (Server) and Port that have been previously set in the Extern→TCP-

IP section of OnAir Setup. 

 

Example: $TA 

 

Alternatively, you can set a different IP and port number directly in the command string: start the command with $}, 

followed by the IP address and port number. 

 

Example: $}10.0.127.62:1327>FE000000062D0441581702184FFF 

 

9.3.C UDP 
 

A UDP command string starts with the +> characters, followed by the IP address and Port number. 

 

Example: +>192.168.99.88:15001>FE000000021C01C9B0FF 

 

9.3.D HTTP 
 

A HTTP command string starts with ^^HTTPGET followed by the http string enclosed in round brackets. 

 

Example: ^^HTTPGET(http://192.168.85.117:8090/BassWrapper/REST/LoadMacro?name=ADVON) 
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NOTE: OnAir can manage HTTP command strings only if, in the On-Air\Communications\Communications 1\HTTP 

section of the OnAir Setup, you activate the Enable parameter 

 

Please contact Axel Technology’s Support Team if you need more info about this matter. 

 

9.3.E SCRIPTS 
 

Scripts are particular instructions used to make OnAir perform specific actions. If associated to a TCP or UDP 

command, they can send the instructions to another OnAir playout. The command string starts with ^^. 

 

Example 1: ^^STARTNEXT 

Example 2: +>192.168.99.9:5000>^^STARTNEXT 

 

Here below a list of the most common scripts: 

 

^^STARTNEXT: stops the item on the air, with fade, and starts the next one. It corresponds to pressing the PLAY 

button on the OnAir window. 

 

^^STOP: stops the item on the air, with fade. It corresponds to pressing the STOP button on the OnAir window. 

 

^^AUTOMATIC: sets OnAir in AUTOMATIC mode. It corresponds to pressing the AUTO button on the OnAir window. 

 

^^MANUAL: sets OnAir in MANUAL mode. It corresponds to pressing the MANUAL button on the OnAir window. 

 

^^ADVAUTOMATIC: sets the OnAir Advertising management in AUTOMATIC mode. It corresponds to pressing the 

AUTO button on the Advertising panel in the OnAir window. 

 

^^ADVMANUAL: sets the OnAir Advertising management in MANUAL mode. It corresponds to pressing the MANUAL 

button on the Advertising panel in the OnAir window. 

 

^^MONITOR(1): stops the OnAir playout and plays the external audio feed ingested to the MONITOR IN. 

 

^^MONITOR(0): stops the playout of the external audio feed and resumes the playout of the playlist by setting the 

AUTOMATIC mode. 

 

^^GPIOUT(0,255): closes all the OUT contacts of the GPIO card that is specified in the OnAir Setup. 

 

^^GPIOUT(0,0): opens all the OUT contacts of the GPIO card that is specified in the OnAir Setup. 

 

^^GPIOUTPIN(x,y): opens/closes a specific OUT contact of the GPIO card that is specified in the OnAir Setup. The 

first value inside the brackets must be set with the OUT number (1 is the first OUT, 2 is the second,…), while the 

second value can be 0 (on) or 1 (off). 

 

Example 1: ^^GPIOUTPIN(1,0) OUT 1 ON 

Example 2: ^^GPIOUTPIN(1,1)  OUT 1 OFF 

 

^^GPIRESET: reinitializes the communication between OnAir and the GPIO card. 

 

^^GPIDISABLED: interrupts the interaction between OnAir and the IN contacts of the GPIO card set in OnAir’s 

configuration. 
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^^GPIDISABLED(s): interrupts the interaction between OnAir and the IN contacts of the GPIO card for a certain 

number of seconds set into the brackets. 

 

^^GPIENABLED: restores the interaction between OnAir and the IN contacts of the GPIO card set in OnAir’s 

configuration. 

 

^^GPIOUTDISABLED: interrupts the interaction between OnAir and the OUT contacts of the GPIO card set in OnAir’s 

configuration. 

 

^^GPIOUTENABLED: restores the interaction between OnAir and the OUT contacts of the GPIO card set in OnAir’s 

configuration. 

 

^^OPENAUDIOCARDS: resets the drivers of the sound cards associated to OnAir. 

 

^^CLOSEPROGRAMM: closes the OnAir playout. 

 

^^FORCEREBOOT: forces the reboot of the machine. 

 

^^SHELL(): this command, associated to an argument, can run a program or open a file 

 

Example: ^^SHELL(C:\MYPROGRAM.EXE) 

 

9.3.F MULTIPLE COMMANDS 
 

It is possible to create a single string with more than one command, separated by the | (pipe) character. OnAir will 

execute the instructions in sequence, as set in the string. 

 

For example, if you want to create a command that sets the OnAir in MANUAL mode and runs a batch file, the string 

will be: 

 

^^MANUAL|^^SHELL(C:\TEST.BAT) 

 

In this way, you can create command strings by mixing scripts with TCP/IP, UDP, HTTP, RS-232 commands. 

 

9.3.G COMMAND EXECUTION METHODS 
 

As we have already written above, the commands can be scheduled or entered manually in the playlist, like an audio 

of any other category, and the OnAir playout will execute them according to the playlist. 

 

There are two other alternative ways to execute commands: 

 

The first one is to open the COMMAND table from OnAir, select the command you want to execute and press the 

PLAY button for the preview on the bottom right, and the command will be immediately executed. 



 
    

 
102 ADVANCED FEATURES |HOW TO SEND SONG INFO ON RDS AND STREAMING 

 

XRadio· User Manual · ENG 

 

 
 

The second one is to create one or more Keyboards, by associating a command to each button (see the paragraph 

for the Hot Keys management). Then, in the OnAir panel, click on the Hot Keys button and load the Keyboard with 

the commands. By clicking on a button, the related command will be immediately executed. 

 
 

 

 HOW TO SEND SONG INFO ON RDS AND STREAMING 
 

OnAir can interface with Axel Technology’s RDS encoders and transmit the information of the audio on the air to the 

Radio Data System (RDS). 

Below, the instruction on how to set both XRadio and the RDS device to send the song info on RDS. 
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9.4.A ONAIR SETUP 
 

First, you must configure the OnAir playout so to generate an XML file with the info of the audio on the air. 

Open the OnAir Setup and, from the tree menu on the left, select On-Air→Now Playing and set the following 

parameters: 

 

Now Playing: set it on 4 – XML 

 

Multiple XML: set the path and name of the XML file where the OnAir will write the info (e.g.: 

\\192.168.99.40\J\PLAYLIST.XML) 

ATTENTION: it is mandatory for the RDS data send that the folder where the OnAir is writing the file is a shared 

source on the network, it cannot be a subfolder of a shared source. 

 

Categories allowed to write the IEM title: in this box, select what are the audio categories that can write their info 

on the XML file 

 

Replacement text for categories not allowed to write the title: enable it, select the text option and write a default 

text that will be used when an audio category that has not been selected in the “Categories allowed to write the IEM 

title” box is on the air 

 

RDSE3/web compatibility mode= this parameter is important for managing the info properly when and advertising 

cluster is on the air. If not enabled, the RDS will show the info of the next item into the playlist when the 

advertisement is playing. 

 

Furthermore, it is possible to set other optional parameters. 

 

Replace XML escape characters with their HTML code: if in your metadata there are songs, or other audio, with the 

title/artist/description containing special characters like the & (ampersand), you need to enable this parameter in 

order to manage these data correctly on the RDS. 

 

Replacement text during local advertising: set an alternative text to be used when OnAir plays the Traffic. 

 

Replacement text during national advertising: useful in Radio systems with split Traffic areas, you can set an 

alternative text to be used when OnAir plays the non-splitted Traffic clusters. 

 

9.4.A RDS ENCODER SETUP 
 

Before proceeding with the Encoder setup, be sure that in the PC where XRadio is saving the XML file with the info 

the SMB File Sharing Support feature is enabled: in Windows 10, open the Control Panel, select Programs and 

Features where you will find, on the left menu, Turn Windows features on or off. In the dialog box that appears, 

check SMB 1.0/CIFS File Sharing Support and click on OK to confirm. 
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Now you can start configuring your RDS device to read the XML file generated by OnAir. 

 

Access the setup interface by writing the IP address on a web browser (Google Chrome, or Mozilla Firefox) and 

setting the administrator’s username and password of the device. 

From the menu on the left, go to Setup → General Setup and scroll down the page until you find the section called 

“SMB/SAMBA Share Settings”, there you must fill all the parameter: 

 

- Active must be enabled in order activate the communication between the device and the Pc where the XML file is 

saved. 

 

- In Hostname IP / Url write the IP address or Network name of the Pc where the XML file is saved. No backslash (\) 

needed before the address or name. 

 

- In Smb/Samba Share write the name of the shared folder where OnAir is saving the XML file. 

ATTENTION: this parameter is case-sensitive, you must write the name of the shared folder respecting small and 

capital letters. Moreover, the XML file must be saved directly in the shared folder; it cannot be in a subfolder, like 

stated in the previous chapter. 

 

- In User Name write Windows user name of the Pc where OnAir is saving the XML file. 

 

- In Password write the password associated to the User Name. Mandatory, the device will not accept a Windows 

user name with no password set. 

ATTENTION: this parameter is case-sensitive, you must write the password respecting small and capital letters. 

Moreover, the password must be letters and numbers only: no spaces, punctuation, or special characters. 

 

If all the parameters are set correctly, the Status will turn to Connected. 
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From the menu on the left, go to RDS/RDBS → Basic Settings→Rds Settings where you will find the section called 

“Rds General Settings”: enable the Rds On parameter and set the Rds Global Extended mode on Enabled. 

 

 
 

Scroll down the page until you find the SMB/SAMBA Share Settings section and set the parameters: 

 

- In File Name, write the name of the XML file. This parameter is case-sensitive. 

 

- In Format, select the format according to your playout. For Djpro OnAir, the right value is DjPro V.2.0. 

 

If the parameters are set correctly, the Status will turn to All Right. 

 

 
 

From the menu on the left, go to RDS/RDBS → Extended Mode→Extended Radio Text where you will find the section 

called “Radiotext Mode”: set the RT Operative Mode on Extended Mode, and the Extended RT Source on 

SMB/SAMBA Share.  

 

The Extended RT Auto Return Time is optional, but if you set the value to, for example, 180 sec, the info of the song 

on the air will appear for three minutes only, then it will be replaced by the default text that has been set in the 

OnAir Setup. 

 

Set Auto-generated RT+ on Enhanced RT+ enable to show the song info on the radio devices that manage the RT+ 

mode 

 

 
 

If you want, you can also show the song info on the PS, go to RDS/RDBS → Extended Mode→Extended PS Name and 

set the parameters as for the Extended Radiotext. 

 

Once you have set all the parameters, if everything is working well, you will see the song info scrolling from right to 

left on the RADIO TEXT & RDS SERVICES panel and, if you configured the dynamic PS too, on the PS-DS-PI-DI panel 
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9.4.B STREAMING SETUP 
 

If you want to send the song info to your web site or mobile application using a third-party software such as EdCast, 

you can select 5 – Single line in the Now Playing parameter and, in the File parameter, set a TXT File (e.g.: 

M:\RADIO\ONAIR.TXT) 

The change of Now Playing parameter from 4 to 5 will not affect the Multiple XML, so OnAir can generate a TXT file 

for the streaming encoder and a XML file for the RDS encoder. 

 

If instead you use Axel Technology’s DJStreamer to manage audio streaming, it reads the same file used by the RDS 

encoders, i.e. the one set in Multiple XML. 

 

 

 SOURCES AUTO-CHANGE FEATURE 
 

9.5.A WHAT IS SOURCES AUTO-CHANGE? 
 

In a system that has a Main Server and one or more backup servers, each XRadio workstation can continuously check 

the mapped drives associated to these servers (sources) according to a priority list order. If the first source in the list 

is available, DjPro uses this one as the Main Server. If a problem occurs on the communication with the Main Server, 

XRadio automatically switches to the second source in the list. Again, if the second source has a problem too, it will 

switch on the third source, and so on, up to the last source that usually is a local drive on the workstation. 

XRadio must be always open if you want this feature to be operative. All the checks are performed in background, 

they don’t affect the normal operations done by the user. 

 

9.5.B HOW DOES IT WORK? 
 

XRadio constantly checks the access to the mapped drives (usually, the M: drive). In case of Main Server failure, 

switch breakdown or a general failure situation, if XRadio recognizes the mapped drives are no longer available, it 
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automatically uses some DOS commands for unmapping the drives from the first source and maps them to the next 

available one. 

 

9.5.C HOW CAN THE USER NOTICE THAT THE MAIN SERVER IS DOWN? 
 

When XRadio is mapped to the Main Server, the 

“Source” circle that you find on the top bar is 

grey colored. When XRadio is mapped on 

another source, the “Source” circle changes its 

color, and a frame of the same color surrounds 

the screen. 

 

Colors for the sources are set by default, but 

they can be customized. 

 

 

 

 

 

9.5.D WHAT TO DO AFTER XRADIO HAS MAPPED ON A SECONDARY 

SOURCE? 
 

When a fault happens, not due to human error, the only way to bring back the Radio station to the normal activity 

is to check the system and solve the issue. Generally, it could be necessary an IT Technician to find the issue and fix 

it. 

 

 
Once normal operation has been restored, after a reverse data backup from the 

secondary source to the Main Server and when you are ready to switch back XRadio 

workstation to the Main Server, in the status bar of the main window click on Server to 

open the Sources list, then double click on the item related to the Main Server to unmap 

the drives from the backup source and map them back to the main source. 

 

 

 

 

 

 

 

 

After this operation, the “Source” circle on top of the screen should turn grey and the frame around the screen 

should disappear. 

If the data of the Main Server and the backup server are synchronized, you can do the switch back from where the 

OnAir PC playout is open and playing, it should not affect the operations since it is a real-time switch. 

 

ATTENTION: XRadio does not automatically switch back to Main Server once it switches to another source. The 

switch back must be done manually, using the method mentioned above. 
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9.5.E HOW TO KEEP THE BACKUP SERVERS UP TO DATE? 
 

To always keep the backup servers updated, you can use professional sync softwares, such as InSync or ViceVersa, 

that allow to schedule a daily backup from the Main Server to the backup sources. 

 

9.5.F HOW TO CONFIGURE XRADIO WITH SOURCE AUTO-CHANGE 
 

Go to Options→Settings from the Menu bar and select Administrator Tools\Sources Autochange. 

 

Parameters to be set: 

MODE: Automatic 

TIMER (s): 10 

 

Configure a Source: 

Press + in the “Drives to be Controlled” section. 

Select the Drive to control (usually it is M:\) and 

confirm. 

Now press + in the “Connection List” side, where 

it is possible to configure all the available 

Sources. In the window that appears you need 

to insert the parameters for the connection of 

the new source. 

 

 

 

 

 

In the picture below, an example for these parameters: 

How to set the commands: 

In CMD Connection you have to insert the command string for 

the connection. The command type can be “NET USE” or 

“SUBST”, depending on the type of connection you need: Net 

Use is for mapping a Network drive, while Subst is for associating 

a drive letter to a local folder. 

 

 

For a help the user can press the ? button on the left side, and a quick guide on the commands appear: 
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Anyway, you can automatically set the commands using the “…” icon to browse the network or the local drives and 

directly select the folder. 

CMD Disconnection 1 and CMD Disconnection 2 are automatically set, but in case you need to insert them again, 

click on the round arrow icon and they will appear in the related fields. This two default Commands are needed for 

unmapping the source before mapping it with the command set in CMD Connection. 

Press the OK button to save changes and close the window. 

 

Follow the same steps to add all the other Sources for the Radio Station. 

 

 

TIP: If you want, you can save the auto-change parameters into an .ACT file that you can use, for example, to load 

the same setup on another DjPro Client. You can find, in the “Default Configurations” section, the options for creating 

a new setup, loading an .ACT file and saving the current settings into an .ACT file. 

When you install XRadio, you are also provided with some sample .ACT files that you can load from 

M:\RADIO\BIN\WINDOWS folder. 

 

 

ATTENTION: the Source auto-change feature must be set for each XRadio Client, so the parameters must be 

configured in each workstation where you want to use it. 

 

 

 

 

 

 


